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Preface 
Manual Information

Purpose This manual provides information on the features and applications for the HView SX Hybrid.

Audience This manual is written for engineers, technicians, and operators responsible for installation, 
setup, maintenance, and/or operation of the product, and is useful to operations personnel 
for purposes of daily operation and reference.

Revision
History

Writing
Conventions

To enhance your understanding, the authors of this manual have adhered to the following 
text conventions:

Table 1-1  Revision History of Manual

Edition Date Comments

A November 2011 Initial release

Table 1-2  Writing Conventions

Term or 
Convention Description

Bold Indicates dialog boxes, property sheets, fields, 
buttons, check boxes, list boxes, combo boxes, 
menus, submenus, windows, lists, and selection 
names

Italics Indicates email addresses, the names of books or 
publications, and the first instances of new terms and 
specialized words that need emphasis

CAPS Indicates a specific key on the keyboard, such as 
ENTER, TAB, CTRL, ALT, or DELETE

Code Indicates variables or command-line entries, such as a 
DOS entry or something you type into a field

> Indicates the direction of navigation through a 
hierarchy of menus and windows
Copyright ©2011, Harris Corporation
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Obtaining
Documents

Technical documents can be viewed or downloaded from our website. Alternatively, contact 
your Customer Service representative to request a document.

Unpacking/Shipping Information

Unpacking a
Product

All products have been carefully inspected, tested, and calibrated before shipment to ensure 
years of stable and trouble-free service.

1 Check the equipment for any visible damage that may have occurred during transit.

2 Confirm that you have received all items listed on the packing list. 

3 Contact your dealer if any item on the packing list is missing. 

4 Contact the carrier if any item is damaged. 

5 Remove all packaging material from the product and its associated components before you 
install the unit.

Returning a
Product

In the unlikely event that a product fails to operate properly, please contact our Customer 
Service Department to obtain a Return Authorization (RA) number, then send the unit back 
for servicing. 

Keep at least one set of original packaging in the event that a product needs to be returned 
for service. If the original package is not available, you can supply your own packaging as 
long as it meets the following criteria:

 The packaging must be able to withstand the product’s weight.

 The product must be held rigid within the packaging.

 There must be at least 2 in. (5 cm) of space between the product and the container.

 The corners of the product must be protected.

If the product is still within the warranty period, we will return it to you by prepaid ground 
shipment after servicing.

Standards There are three sets of standards used in the development of the HView product line: 
product standards, compliance standards, and safety standards.

hyperlink Indicates a jump to another location within the 
electronic document or elsewhere

Internet address Indicates a jump to a website or URL

Indicates important information that helps to avoid 
and troubleshoot problems

Table 1-2  Writing Conventions
pyright ©2011, Harris Corporation
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Product
Standards

The following product standards apply to the HView output module. Please reference the 
pertinent standard for more information.

Professional Video
SMPTE 259M
SMPTE Standard for Television - 10-Bit 4:2:2 Component and 4fsc Composite Digital Signals 
- Serial Digital Interface

SMPTE 292M
SMPTE Standard for Television - Bit-Serial Digital Interface for High Definition Television 
Systems

SMPTE-170M
For Analog Video Signal quality

FCC 73.699
U.S. Federal guidelines for NTSC analog composite video

ITU-R.BT 470
Guidelines for PAL analog composite video

ITU-R BT601-4
For Serial Digital Video

SMPTE 296M 
SMPTE Standard for Television - 1280x720 Progress Image Sample Structure - Analog and 
Digital Representation and Analog Interface

SMPTE 274M
SMPTE Standard for Television - 1920x1080 Image Sample Structure, Digital Representation 
and Digital Timing Reference Sequences for Multiple Picture Rates.

SMPTE 424M
SMPTE Standard for Television - 3 Gb/s Signal/Data Serial Interface

DVI 1.0
Digital Visual Interface 1.0, Digital Display Working Group (DDWG) (www.ddwg.org).

SMPTE 12M
SMPTE Standard for Television - Audio and Film - Time and Control Code

Digital Audio
AES3-2003
AES Recommended Practice for Digital Audio Engineering - Serial Transmission Format for 
Two-Channel Linearly Represented Digital Audio Data

AES3id-2001
AES Information Document for Digital Audio Engineering -Transmission of AES3 Formatted 
Data by Unbalanced Coaxial Cable

SMPTE 276M-1995
SMPTE Standard for Television - Transmission of AES-EBU Digital Audio Signals Over Coaxial 
Cable 
Copyright ©2011, Harris Corporation
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PT-PS Power Supply
Safety
TUV approved to latest revision of UL 60950-1 and CSA 22.2 complete with CB Report with 
all country deviations1

CE Mark
EMC Compliance tested under EN 55103-1, 2 as a Class A Device in an E4 environment

Other Interfaces
IEEE 802.1 (Ethernet)
CSMA/CD Access Method

USB 2.0
Universal Serial Bus 2.0 (www.usb.org)

RS-232 (TIA-232-F)
Interface Between Data Terminal Equipment and Data Circuit-Terminating Equipment 
Employing Serial Binary Data Interchange

ANSI/TIA/EIA-422-B
TIA-422 Electrical Characteristics of Balanced Voltage Differential Interface Circuits

Compliance
Standards

EMC Compliance Standards
The following EMC compliance standards apply:

 EN 50081-1

 EN 55022

 EN 50082-1

 IEC 1000-4-2 1995-01

 IEC 801-3 1984

 IEC 1000-4-4 1995-01

 Part 15 of the FCC Rules

 ICES-003 of the Canadian Department of Communications

Restriction on Hazardous Substances (RoHS) Compliance
Directive 2002/95/EC—commonly known as the European Union (EU) Restriction on 
Hazardous Substances (RoHS)—sets limits on the use of certain substances found in 
electrical and electronic equipment. The intent of this legislation is to reduce the amount of 
hazardous chemicals that may leach out of landfill sites or otherwise contaminate the 
environment during end-of-life recycling. The Directive, which took effect on July 1, 2006, 
refers to the following hazardous substances: 

 Lead (Pb)

 Mercury (Hg)

1. A total of 8 PT-PS power supplies can be used in the Platinum frame. TUV will test for frame 
leakage currents using all 8 power supplies operating simultaneously to determine the total frame 
leakage current. This total frame leakage current value must meet EN60950 and CSA 22.2.
pyright ©2011, Harris Corporation
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 Cadmium (Cd)

 Hexavalent Chromium (Cr-V1)

 Polybrominated Biphenyls (PBB)

 Polybrominated Diphenyl Ethers (PBDE)

In accordance with this EU Directive, all products sold in the European Union will be fully 
RoHS-compliant and “lead-free.” (See our website for more information.) Spare parts 
supplied for the repair and upgrade of equipment sold before July 1, 2006 are exempt from 
the legislation. Equipment that complies with the EU directive will be marked with a 
RoHS-compliant emblem, as shown in Figure P-1.

Figure P-1  RoHS Compliance Emblem

Waste from Electrical and Electronic Equipment (WEEE) 
Compliance
The European Union (EU) Directive 2002/96/EC on Waste from Electrical and Electronic 
Equipment (WEEE) deals with the collection, treatment, recovery, and recycling of electrical 
and electronic waste products. The objective of the WEEE Directive is to assign the 
responsibility for the disposal of associated hazardous waste to either the producers or users 
of these products. Effective August 13, 2005, producers or users will be required to recycle 
electrical and electronic equipment at end of its useful life, and may not dispose of the 
equipment in landfills or by using other unapproved methods. (Some EU member states 
may have different deadlines.)

In accordance with this EU Directive, companies selling electric or electronic devices in the 
EU will affix labels indicating that such products must be properly recycled. (See our website 
for more information.) Contact your local sales representative for information on returning 
these products for recycling. Equipment that complies with the EU directive will be marked 
with a WEEE-compliant emblem, as shown in Figure P-2.

Figure P-2  WEEE Compliance Emblem
Copyright ©2011, Harris Corporation
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Safety
Standards

The following safety standards apply:

 IEC-950

 UL 60950-1

 EN60950: 1992 + A1: 1993 + A2: 1993 +A3: 1995 A4: 1997 +A11: 1997 EMKO-TSE 
(74-SEC) 207/94

 UL1419

 CSA C22.2 No. 1

Safety Carefully review all safety precautions to avoid injury and prevent damage to this product or 
any products connected to it. Any user-serviceable components (such as fuses or batteries) 
are only replaceable by those components listed in the manual.

IMPORTANT! Only qualified personnel should perform service procedures.

Safety Terms and Symbols in this Manual

WARNING
Statements identifying conditions or practices that may result in 
personal injury or loss of life. High voltage is present.

CAUTION
Statements identifying conditions or practices that can result in 
damage to the equipment or other property.
pyright ©2011, Harris Corporation
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1 Introduction
Overview The HView SX Hybrid output module occupies four slots in the output section of a Platinum 
router. With the multiviewer fully-integrated into your routing network, it can display any of 
the Platinum router input sources. These can be selected from a wide variety of input 
modules: auto-detecting 1080p/HD/SD video with embedded audio, analog video, and 
graphics input as well as discrete analog or AES audio.

The HView SX Hybrid supports all critical display resolutions up to 1900×1200 dpi, and the 
DVI outputs can be set for any of the supported resolutions. You can select between two 
output display modes as well as select either portrait or landscape orientation so that you 
best utilize your output display devices. The HView SX Hybrid allows custom resolutions, for 
example 1080×1100. 

In addition to the multiviewer’s outputs, connectors are provided for two Ethernet 
connections, a linear timecode input, four USB ports, and AES outputs for audio monitoring.

You can use the Layout Designer software that comes with your multiviewer to monitor all 
audio and video signal characteristics through integrated alarms, audio metering, and other 
test and measurement tools. With Layout Designer, you can also select preset layouts and 
create custom layouts. When connected to a CCS network, your HView SX Hybrid can be 
controlled by CCS control applications such as CCS Navigator and NUCLEUS network 
control panel. For more information about Layout Designer features, see Layout 
Designer on page 3.

Main Features

Audio and Video/Graphic Inputs
 Up to 512 input video sources

 System scalability that allows you to put multiple output modules in a 9RU, 15RU, or 
28RU Platinum frame

 Auto-detection and support of 3Gbps-SDI, HD-SDI, and SD-SDI including embedded 
audio 

 Using specific Platinum input modules, auto-detection and support of analog video 
inputs or destination monitoring, discrete analog audio, and discrete AES audio

 Support for the following video standards:

 486i@59.94 fps (SMPTE 125M)
Copyright ©2011, Harris Corporation
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 576i@50 fps (ITU-R BT.656)

 720p@59.94 fps (SMPTE 292M, SMPTE 296M)

 720p@50 fps (SMPTE 292M, SMPTE 296M)

 1080i@59.94 fps (SMPTE 292M, SMPTE 274)

 1080i@50 fps (SMPTE 292M, SMPTE 296M)

 1080psf@23.98 fps 

 1080p@24, 25, and 30 fps 

 3Gbps 1080p@50 and 60 fps 

 Input for an external linear code signal for on-screen clock time reference source 

Communication
 Serial connection provides connection to a serial breakout provides two RS-232 and 

two ports that can be configured as RS-232, RS-422, or RS-485

 Four type A USB ports on the back module and two type A USB ports on the front 
module can be used for general purposes such as computer mouse and keyboard 
connections (for Heads-Up operations)

 Two 10/100/1000 Ethernet ports for communication with Layout Designer, other 
CCS-networked devices, JLCooper eBOX, and GPIO devices

Monitoring
and Control

 Standard multiviewer system audio and video alarms such as signal presence, freeze 
detection, black detection, audio overshoot, and silence detection 

 On-Screen application to manipulate the multiviewer right on the display, eliminating 
the need for an external computer to make adjustments to layouts 

 Waveform monitor and vectorscope capabilities to monitor the video quality control of 
one video source at a time, to ensure it complies with the required standards

 The Rules Editor to program the multiviewer to respond to video, audio, system or 
facility alarms. These can range from sending out alarm notifications into a network by 
E-mail, to switching layouts on the multiviewer or switching sources on a Platinum 
router 

 The Triggers Configuration Window for programming the multiviewer to perform 
specific tasks at different times.

Output
Display

 Outputs up to 64 HD-SDI displays or up to 32 DVI displays from a single 28RU Platinum 
frame with up to 16 multiviewer output modules. There are 32 addressable inputs, to a 
maximum of 64 PiP (picture-in-pictures) windows per multiviewer, shared across all 
displays. 

 Provides three user-selectable output modes for DVI and SDI outputs:

 Independent mode—One layout per display (dual or quad display) 

 Spanning mode—More than one display per layout

 Redundant mode—two copies of the same layout

 AES audio monitoring using external monitoring devices
pyright ©2011, Harris Corporation
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Layout
Designer

Layout Designer is the primary configuration and control application for multiviewer 
systems. You can connect a multiviewer to a PC that is running Layout Designer by using 
one of the Ethernet connections on the back module. In addition to multiviewer 
configuration and control, Layout Designer provides signal monitoring, alarm feedback, and 
layout creation and design capabilities. Layout Designer features include, but are not limited 
to, the following: 

 Standard and customized layout templates, Picture-in-Picture (PiP), borders, and labels

 On-screen clocks and counters that can be locked to an external timecode reference 
source

 User-definable rules generator and manager

 Standard and custom UMD/Tally indicators

 Audio meters and video signal analysis/monitoring 

 On-screen audio and video alarms.

For more information about using Layout Designer with your multiviewer system, see 
About Layout Designer on page 24 or your Layout Designer Software Application User 
Guide. 

You can also use the on-screen control application for limited control of your multiviewer 
system without external software or other CCS network control devices. For more 
information, see Multiviewer Configuration and Control on page 23.

CCS Control with Navigator and NUCLEUS
Using CCS Navigator and NUCLEUS, you can do the following. 

 Select layouts that are stored on the multiviewer hardware for display

 Monitor multiviewers for audio and video signal alarms as well as alarms for system 
diagnostics

Applications
HView SX Hybrid systems can be used for, but are not limited to, the monitoring and control 
of the following broadcast facility environments.

 Network master control operations

 Satellite uplink stations

 Fixed sporting installations

Non-broadcast applications of Layout Designer include

 Government installations

 Data monitoring facilities 

 Security monitoring and surveillance for highways, public transportation systems, 
casinos, sports stadiums, etc. 
Copyright ©2011, Harris Corporation
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Output Module

Only qualified service technicians should attempt to service the output module.

The output module is a self-contained unit that performs all of the system video input and 
output processing. It occupies four slots in the output section of any Platinum routing 
frame. The multiviewer receives up to 32 baseband 
3.0 Gbps video signals or 24 scaled video channels from the frame’s crosspoint matrix 
module. A series of fans maintains optimal operating temperature inside the output 
module. (Temperatures can be monitored using CCS Navigator.)

The multiviewer’s back module, which is connected to the back of the Platinum frame, 
provides all of the connectors for output video signals, communication devices, and external 
devices. Each output module can output two DVI and four SDI video output signals that 
drive the multiviewer output displays. 

For information about the back module connectors, see Back Module Connectors on 
page 7. 

Figure 1-1  Multiviewer Hardware Output Module

The multiviewer’s main components are:

Interconnect area
with MI modules

Front view and fan assembly

Back module 
connectors

Installation 

Front view

The output module front has the ejector/locking mechanism 
and provides access to the multiviewer’s serviceable 
components (see Front View and Fan Assembly on 
page 5).
pyright ©2011, Harris Corporation
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Front View
and Fan

Assembly

The module’s front view provides access to the output module’s LEDs and alarm indicators. 
The output module’s fan assembly ensures that the enclosed hardware is operating at 
optimal temperature. 

Figure 1-2  Output Module Front View

Installation guides

Installation guides on both sides of the output module guide 
the unit when it is installed in a Platinum frame. For 
information about installing the module, see Installing 
Overview on page 16.

Interconnect area
This area provides connectivity to the Platinum frame’s MI 
module. Input signals from the router’s crosspoint modules 
are routed to the output module through this connection.

Back module 
connector

The back module provides all the connectors for external 
device connections (see Back Module Connectors on 
page 7).

Reset Button

The Reset button restarts the output module without power 
cycling the unit. Use the Reset button if starting the unit 
from Layout Designer or the Multiviewer Control Panel failed 
when a multiviewer needs to be restarted while the rest of 
the Platinum frame remains powered up. 

USB Connector
Use the USB connector for attaching a USB memory stick for 
firmware upgrading or installing new applications. 

Monitoring LEDs
Monitoring LEDs are located on the front of the output 
module. Table 1-1 on page 5 describes the meaning of each 
LED.

Table 1-1  LED Status Indicators 

LED Color 
Indication Description

On Solid green The output module is fully powered up.

COM Flashing, green
Not currently implemented. 

Solid, red

Fan assembly

Monitoring LEDsReset button

Ejector/locking handle
Copyright ©2011, Harris Corporation
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Proc Flashing, green The output module’s Central Processing Unit (CPU) 
and Graphic Processing Unit (GPU) are working 
properly (heartbeat OK).

Solid, green or 
red

The CPU is not working properly (heartbeat error).

Flashing, red The GPU is not working properly (heartbeat error). 

Drive A Solid, green Internal drive A is working properly.

Solid, red There is an error on internal drive A. 

Drive B Solid, green Internal drive B is working properly (Drive B is 
reserved for future use and is normally off).

Solid, red There is an error on internal drive B.

Act Flashing, green There is activity on internal drive A or B.

Video In Solid, green
Not currently implemented. 

Video Out Solid, green

Net 1 
Link

Solid, yellow A valid connection is present on Ethernet 
connection 1.

Net 1 Act Flashing, green There is network activity on Ethernet connection 1. 

Net 2 Lnk Solid, yellow A valid connection is present on Ethernet 
connection 2. 

Net 2 Act Flashing, green There is network activity on Ethernet connection 2. 

Table 1-1  LED Status Indicators (Continued)

LED Color 
Indication Description
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Back Module
Connectors

The output module back connectors provide all of the connectors for network and RS-232/
422/485 communication, external device inputs, and the output video signals.

Figure 1-3  Output Module Back Connectors

DVI output 
connector

USB 2.0 
type A
connectors

DB-26 serial
connector

AES3 audio output 
connectors

DVI output 
connector

10/100/1000 
Ethernet ports

USB 2.0 
type A
connectors

SDI output connectors

For future 
use

Linear timecode input

For future 
use

SDI outputs

The four SDI outputs are capable of driving HD-SDI display 
devices. The SDI outputs cannot be used in combination with 
the DVI outputs. For information about connecting SDI 
outputs, see Connecting Output Display Devices on 
page 15 and Connecting HDTV Display Devices to the 
Multiviewer on page 17.

DVI outputs

The two DVI outputs are capable of displaying a number of 
video standards and resolutions. The signals are primary RGB. 
The DVI outputs cannot be used in combination with the SDI 
outputs. For information about connecting DVI outputs, see 
Connecting Output Display Devices on page 15 and 
Connecting HDTV Display Devices to the Multiviewer on 
page 17.

USB type A
These four USB ports can be used for various purposes. You 
can use the USB ports to attach a mouse and keyboard to 
navigate and control the Multiviewer’s on-screen tools. 
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Figure 1-4  Ethernet Port LEDs

DB-26 connector

This the connector for a breakout cable. The breakout cable 
has four DB9 ends to provide four Serial ports. Serial ports 1 
and 2 are configured in the software to be RS-232, RS-422, or 
RS-485. Serial ports 3 and 4 are fixed RS-232. These serial 
ports can be used to connect the multiviewr to Under Monitor 
Display (UMD) generators, production switchers, or other 
routers. For more information, see Serial Breakout Cable on 
page 9.

AES3 audio 
output

Two AES discrete audio outputs are provided for monitoring 
purposes with external audio monitoring devices. See 
Connecting Output Audio Monitoring Devices on 
page 24.

10/100/1000 
Ethernet

Two Ethernet ports provide connectivity with Layout Designer 
and CCS control systems, such as CCS Navigator and 
NUCLEUS network control panel. In addition, the Gbps 
Ethernet connections can be used to connect the multiviewer 
to an external GPI hardware interface such as the JLCooper 
eBOX (a 10/100Base-T to Quad RS-232/422 (9-Pin) and GPI 
hardware interface. For more information, see Network 
Connections on page 20.

Table 1-2  Ethernet Ports LED Status Indicators

LED Color Indication  Description

ENET 1 Network 
Link LED

 Solid, green A valid connection is present on 
Ethernet port 1.

ENET 1 Network 
Activity LED

 Flashing, yellow There is network activity on 
Ethernet port 1.

ENET 2 Network 
Link LED

 Solid, green A valid connection is present on 
Ethernet port 2. 

ENET 2 Network 
Activity LED

 Flashing, yellow There is network activity on 
Ethernet port 2. 

ENET 1 ENET 2

Network 
Link LED

Network 
Activity 
LED

Network 
Link LED

Network 
Activity 
LED
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External Hardware Components
Back connectors can accommodate external hardware components that provide additional 
system connections. Each external hardware component is described in the following 
sections.

Serial
Breakout

Cable

The serial breakout cable expands the back module’s serial port from one DB-26 connector 
into four separate DB-9 pin connectors. Ports 1 and 2 can be configured for either RS-232, 
422, or 485. Ports 3 and 4 support RS-232 only.

Figure 1-5 illustrates the serial breakout cable. 

Figure 1-5  Serial Breakout Cable

For information about setting the type of serial connection, pinouts, and making serial 
connections, see Connecting Devices to the Serial Connection on page 24.

Third-Party
GPI Hardware

Interface

Your HView SX Hybrid is compatible with the JLCooper eBOX. The JLCooper eBOX provides 
access to up to 24 GPI inputs and outputs. When the multiviewer is attached to the same 
TCP/IP network using its own Ethernet connector, it can access the JLCooper eBOX. 

For information about configuring your e-BOX, see your JLCooper eBOX documentation. 
See Configuring Multiviewers for Router Follow on page 53 and Connecting 
JLCooper eBOX Devices on page 19.

DB-26 male connector

Port 1 Port 2 Port 3 Port 4
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2 Installation 
Installing and Connecting Overview
The output modules are installed in the output section of Platinum router frames. Each 
output module occupies four output slots in the router frame. Since the output module is 
shipped as a complete “solid-state” unit, you do not need to install individual components. 

Potentially lethal voltages are present within the Platinum frame during normal 
operation. Disconnect all power cords from the frame before you remove the top 
panel. Do not apply power to the frame while the top is open unless the unit is 
being serviced by properly trained personnel.

Output modules are hot-swappable, and they do not need to be installed next to each other. 
However, keep in mind that the slots you select to install the multiviewer may affect how 
efficiently you can populate other output slots in the router. 

We recommend that you test your system before its final installation. Make sure 
that you verify its configuration, cabling, and proper system operation. Observe 
proper anti-static and grounding procedures while handling loose boards and 
servicing equipment.

Video inputs are routed from Platinum crosspoint modules to the inputs of the output 
module. The number of multiviewer modules that you can install in a Platinum router is 
determined by the size of the router frame. Table 2-1 lists the number of supported output 
modules that can be installed in 9RU, 15RU, and 28RU Platinum router frames.

Your sales representative can tell you whether you have sufficient power supplies installed in 
the frame to power the installed modules. 

Table 2-1  Number of Installed Output Modules in Platinum Frames

Platinum 
Frame 
Size

Max. Number of 
Installed Output 
Modules

Number of Input 
Channels

Number of DVI 
Outputs

Number of SDI 
Outputs

5RU 2 72 4 8

9RU 4 128 8 16

15RU 8 256 16 32

28RU 16 512 32 64
Copyright ©2011, Harris Corporation
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Table 2-2 provides information about the number of embedded, discrete analog, and 
discrete AES audio inputs that are supported when the multiviewer is installed in 9RU, 
15RU, and 28RU Platinum frames.

Figure 2-1 illustrates two output modules installed in a 15RU Platinum router frame.

Figure 2-1  Platinum 15RU Router Frame with Output Modules

Check the release notes for your devices to determine compatibility between diffferent 
hardware and software versions, in particular the multiviewer module and PT-RES module 
versions. 

Table 2-2  Audio Configurations

Audio Input Type 9RU (16 Slots) 15RU (32 Slots) 28RU (64 Slots)

Embedded Channels 128 per module
2048 per frame

128 per module
4096 per frame

128 per module
8192 per frame

Discrete Analog 
(stereo/mono)

16/32 per module
256/512 per frame

16/32 per module
512/1024 per frame

16/32 per module
1024/2048 per frame

Discrete AES 
(balanced/
unbalanced) 

16 per module
256 per frame

16 per module
512 per frame

16 per module
1024 per frame
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Installing Multiviewer Hardware 
The following sections describe how to install back modules and output modules in 
Platinum router frames. Output modules can be installed without powering down your 
Platinum router frame.

Installing
the Back

Module

A back module takes up four slots in the output section of your Platinum router frame.

1 Remove any currently installed Platinum output back modules from the appropriate four 
slots (per output module) where you want to install the back module.

2 Remove the blank covers or output module back connector of the appropriate four slots 
(per output module) on the rear of the Platinum frame (a #1 Phillips-head screwdriver is 
required).

3 Carefully align and then attach the back module over the empty slots using the captive 
screws. Do not discard the screws, as you will need them again. 

Do not tighten down the screws completely when installing the back module. First, install 
the output module, and then tighten the back module screws. 

Installing the Output Module

Before you install the output module, ensure you properly align the module with 
the appropriate guide notches in the router frame. Failure to do so may damage 
the pin connections between the back and output modules. 

1 If you have not done so already, remove any currently installed Platinum output modules 
from the appropriate four slots (per output module) where you want to install the output 
module.

2 Open the I/O Guide door. 
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3 Align the installation guides on the left and right sides of the back module with the guide 
notches of the appropriate slots in the Platinum frame (see Figure 2-2). 

Figure 2-2  Installing the Output Module

4 Pull and hold the back module’s extractor handle, and then slide the back module assembly 
into the frame until it is fully seated.

5 Let go of the extractor handle and push it into the locking position.

6 Close the I/O Guide door. 

Making System Connections
The following sections provide information about making output module connections, 
including the following:

 Ethernet connections for CCS/router network and Layout Designer

 DVI and SDI output display devices

 Audio monitoring devices

 Serial breakout cable

 Ethernet connections to third-party GPI I/O hardware interface 

 LTC connections 

Guide notches on Platinum frame

Output module installation guides

Extractor handle

Fan unit 1 Fan unit 2
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Securing Your Device Cabling

When making connections from external devices to the multiviewer, it is important 
to properly secure the cables to your equipment rack. Use cable ties to secure the 
various device cables to your equipment rack so that the rack supports the weight 
of the cables. Failure to do so will cause excessive weight on the back module and 
breakout module connections and connector pins, which may permanently 
damage your system. 

Network
Connections

Each HView SX Hybrid has two Ethernet connections that allow you to connect directly to a 
local PC running Layout Designer software or to CCS network. When the multiviewer is 
connected to a CCS network, you can use CCS control options such as CCS Navigator and 
NUCLEUS.

Connecting Output Display Devices
The Multiviewer’s back module provides two DVI and four HD/SD-SDI output connections. 
You must configure the multiviewer to display either two DVI or four SDI outputs. You 
cannot send layouts to the DVI and SDI outputs simultaneously.

Note: The DVI connectors labeled DVI 3 and DVI 4 on the back module are for future use.

Figure 2-3  SDI Output Connectors

SDI Outputs 3 and 4

SDI Outputs 1 and 2
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Table 2-3 lists the output display resolutions supported by the HView SX Hybrid’s DVI and 
HD-SDI outputs.

1For these resolutions, the multiviewer hardware supports both 50 Hz and 60 Hz output.

2These resolutions are not available in Quad SDI mode. 

Supported DVI output resolutions are subject to the capabilities of the connected DVI 
display. Support cannot be guaranteed for displays with non-standard timing. 

Output Display Modes
You can operate the multiviewer in either Redundant, Independent, or Spanning mode. You 
can select the display mode for your output module using Layout Designer. See the 
Multiviewers Configuration chapter in your Layout Designer Software Application User 
Guide.

 Redundant mode - Displays the same layout on each output. By default, your output 
module is set to Redundant mode.

 Independent mode - Displays a different layout on each output. When using this 
mode, each output can be configured for different format, aspect ratio, and 
orientation.

 Spanning Mode - Displays (or spans) one layout across outputs. When using this 
mode, each output must be configured for the same format, aspect ratio, and 
orientation.

Table 2-3  Supported Output Resolutions 

DVI Output Resolution HD-SDI and SD-SDI 
Output Resolution

When Redundant DVI, spanned DVI, Dual 
DVI, or Spanned Vertical DVI is chosen

 1080i @ 50 Hz 

 1080i @ 59.94 Hz 

 720p @ 50 Hz 

 720p @ 59.94 Hz 

 SD 525 59.94 

 SD 625 50 

 1080p @ 59.94 Hz2 

 1080p @ 50 Hz2 

 1024 × 768  

 1024 × 800

 1152 × 864

 1280 × 720

 1280 × 768 

 1280 × 800

 1280 × 960

 1280 ×1024 

 1344 × 840

 1440 × 1050

 1440 × 900

 1440 × 1080

 1600 × 900

 1600 × 1024

 1600 × 1200 

 1680 × 1050 

 1792 × 1344

 1856 × 1392

 1920 × 1080

 1920 × 1200 

 1400 × 1050 

When Quad DVI is chosen

 1280 × 720 

 1024 × 768 

 1440 × 900

 1280 × 1024
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Connecting DVI Display Devices to the Multiviewer 
Depending on your output display device and the type of DVI output you are using, use the 
following DVI cabling guides:

 Standard DVI-I digital/analog cable  - Use this cable when outputting to a PC digital 
(DVI) and analog (VGA) video monitor. This cable has a 29-pin DVI/VGA combined 
receptacle connector.

 Standard DVI-D digital-only cable  - Use this cable when outputting digital (DVI) 
video signals only. This cable has a 19-pin DVI-D digital-only receptacle connector (no 
key slot on left side of connector)

 VGA cable with VGA-DVI adaptor, or DVI-A cable with DVI-VGA adaptor  - Use 
this cable when outputting analog (VGA) video signals only. This cable has a 17-pin 
connector that requires an appropriate adaptor and corresponding cable.

Connecting HDTV Display Devices to the Multiviewer 
The multiviewer’s back module provides four BNCs per IEC 169-8 for connecting to HD-SDI 
monitors. For specification information, see HD-SDI Outputs on page 72.

Connecting Output Audio Monitoring Devices
Use the back module’s two digital audio monitoring outputs to connect compliant audio 
monitoring devices, for driving devices such as speakers or headphones, to the multiviewer. 
This allows audible monitoring of audio sources for any two program signals that are 
currently being monitored by the multiviewer. Selection of channels to monitor can be 
chosen from a single stereo pair, or any two mono channels associated with the specific 
program signal. 

Figure 2-4  AES Audio Outputs (Standard Coaxial/Unbalanced) 

For audible monitoring, the program signals must be routed to one of the displays 
associated with the multiviewer. You can use Navigator or NUCLEUS Control Panel to route 
these signals. See Multiviewer System Parameters and Alarms on page 44 or your 
NUCLEUS Multiviewers Control Option Configuration and Operation Manual for more 
information. 

The audio source that will be output must be synchronized with the sync source. Otherwise 
you will hear audio pops. 

Connecting Devices to the Serial Connection
The serial breakout cable expands the back module’s serial inputs from one DB-26 
connector into four separate DB-9 pin connectors each representing a serial port. These 
serial ports can be used for applications such as the following:

Standard coaxial/unbalanced 
output audio connectors
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 Connecting your multiviewer to external UMD devices 

 Facilitating a Harris snoop application

 Providing EAS alert data from TFT and Sage boxes

Table 2-4 provides connection and configuration information about each serial port.

Serial Ports 1 and 2 can have a software-selectable termination enabled on each receiver's 
port. The termination resistor value is 120. This is most often used in RS-422 
point-to-point connections. In the case of RS-485, if the multiviewer unit is at the end of the 
RS-485 bus, this termination can be activated to terminate the bus. 

Table 2-5 provides pinout information for the serial breakout cable’s DB-26 and each DB-9 
connector.

Table 2-4  Multiviewer Serial Breakout Cable Information 

Serial Port 
Number Connector User-Configurable Supported 

Protocols 

1 DB 9 (male) Yes  RS-232

 RS-422

 RS-485

2 DB 9 (male) Yes  RS-232

 RS-422

 RS-485

3 DB 9 (male) No RS-232

4 DB 9 (male) No RS-232

Table 2-5   Serial Breakout Cable Pinouts 
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Description

Pin 
Number

Pin 
Number

Pin 
Number

Pin 
Number

Pin 
Number

1 1 Ground

3 2 RS-232 RX or RS-422/485 TX-

19 3 RS-232 TX or RS-422/485 RX+

4 4 Ground

5 5 Ground

6 6 Ground

2 7 RS-422/485 TX+

20 8 RS-422/485 RX-

9 9 Ground

18 1 Ground

7 2 RS-232 RX or RS-422/485 TX-

21 3 RS-232 TX or RS-422/485 RX+

14 4 Ground
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Connecting
JLCooper

eBOX Devices

HView SX Hybrid systems are designed to work with JLCooper eBOX Quad Serial to 
Ethernet Interface. You can control up to 24 GPI input and 24 GPI output devices per eBOX. 
The multiviewer communicates with eBOX through one of the output module’s Ethernet 
connections. To connect the eBOX to an output module, both the multiviewer and 
JLCooper eBOX must be on the same network and able to communicate with each other. 
See Configuring Multiviewers in a Local Area Network on page 35 for more 
information.

Extra serial ports available: 

 4x 9-Pin D Sub Serial Connectors 

 2x 25 Pin D Sub GPI Connectors 

The GPI In connector has 24 TTL/CMOS compatible inputs with internal pull-ups to +5 volts. 
The GPI Out connector has 24 TTL/CMOS compatible outputs. On both connectors, pin 1 is 
the ground reference and pins 2-25 are GPI signals 1-24. The eBOX also has an • RJ-45 
Ethernet Connector for LAN, WAN or Internet Control. 

The eBOX must be set as a server only, and only a single multiviewer can be connected to 
each eBOX link. The master/slave function allows UMD-tally data to go through the master 
multiviewer without external wiring. 

To configure the eBOX, follow these steps: 

1 Set SW8 to the ON position, and then re-power to access the Configuration Web Server for 
the eBOX.

2 Set SW1, SW2, and SW3 to the DOWN position, and then re-power.

13 5 Ground

12 6 Ground

8 7 RS-422/485 TX+

22 8 RS-422/485 RX-

11 9 Ground

23 2 RX (RS-232)

24 3 TX (RS-232)

16 5 Ground

15 9 Ground

26 2 RX (RS-232)

25 3 TX (RS-232)

17 5 Ground

10 9 Ground

Table 2-5   Serial Breakout Cable Pinouts (Continued)
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3 Using an external PC (on the same sub-network), launch a Web Browser and type the IP 
Address of the eBOX. 

Do not use Internet Explorer 7 or Firefox web browser to change he network 
settings on the eBOX. Internet Explorer 6 is the only authorized application for 
getting into the built-in Web Server to change the network settings.

The eBOX’s default IP address is 192.168.254.102. 

Figure 2-5  eBOX Web Interface

4 Make the necessary Network changes and setup Port # 23. 

5 Remove any Password, and then press the SUBMIT button.

6 Set SW1, SW2, SW3, and SW6 to the ON position, and set SW7 and SW8 to the OFF 
position. 

Figure 2-6  eBOX Dip Switch Settings for Operation

7 Re-power the unit.

8 Ping to confirm the new Network setting.

For information about configuring your e-BOX, see your JLCooper eBOX documentation.

Connecting a Linear Timecode Input Reference Signal
You can input balanced linear timecode (LTC) from a time reference source. The LTC input 
signal can be used as a time reference for on-screen clocks and counters that are displayed 
in multiviewer layouts. Using Layout Designer, you can also configure offsets for the LTC 
input signals. 

HView SX Hybrid supports the following timecode formats:
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 Leitch 12

 SMPTE 12M

 SMPTE 309 M

Figure 2-7 illustrates the LTC input with pin information.

Figure 2-7  LTC Input Pin Information 

Connecting Matrox TripleHead2Go For Quad DVI Mode
In order to output to four monitors at once (Quad DVI mode), you must have two Matrox 
TripleHead2Go devices, one connected to DVI Output 1, and the other connected to DVI 
Ouput 2, using a Dual link DVI-D cable. 

TripleHead2Go setup information is provided in a separate document. Please contact 
Customer Service for complete installation instructions. 

Matrox TripleHead2Go devices require the latest firmware to operate correctly with a 
multiviewer system. If Matrox TripleHead2Go devices are received from our factory, then 
they will have been updated with the latest firmware.  

Do not use DVI outputs 3 and 4. These outputs are reserved for future use. 

Figure 2-8  DVI Outputs 1 and 2 

To connect the Matrox TripleHead2Go devices for operation with the HView SX Hybrid, 
follow these steps: 

1 Shut down the HView SX Hybrid. 

2 Connect the DVI and USB cables from the Matrox TripleHead2Go device to as in Figure 2-9. 

Positive Ground Negative

DVI Outputs 1 and 2
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Figure 2-9  Connecting Matrox TripleHead2Go Boxes

3 Connect the monitors to the Matrox TripleHead2Go boxes to output 1 and output 3 on the 
TripleHead2Go device. 

Output 2 should remain capped, since this output is not used. 

4 Start the multiviewer. 

The LED above the lightbulb symbol on the Matrox TripleHead2Go devices should be green 
when in normal operation. 

DVI output 1

Matrox device

Output 1

Output 3

Output 2 (capped )

Monitors

DVI output 2

Matrox device

Output 1

Output 3

Output 2 (capped )

HView SX Hybrid

USB cable

USB cable
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3 Configuration and Operation
Multiviewer Configuration and Control
There are a number of configuration, control, and monitoring options that you can use with 
your multiviewer. All multiviewer control, test, and monitoring capabilities can be accessed 
remotely using Layout Designer or through CCS network control options such as CCS 
Navigator and NUCLEUS Network Control Panel. Figure 3-1 illustrates a typical control and 
monitoring scenario.

Figure 3-1  HView SX Hybrid Configurations and Control

DVI displaysPlatinum routers with 
multiviewer output modules

Remote control and 
monitoring with CCS 

networked control devices 

Configuration , control 
and monitoring with 

Layout Designer

Layout  Designer

CCS Navigator  NUCLEUS Network 
Control Panel

SDI displays
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All control and monitoring communication with the multiviewer occurs through the output 
module’s Ethernet port. With the exception of adding the multiviewer to a router system 
database, no control of the multiviewer is possible from the Platinum frame Ethernet 
connections. You cannot add a multiviewer to a router system database from Platinum, but 
you can add it through a PC connected via Ethernet to a Platinum router. 

For information about making network connections, see Network Connections on 
page 15.

Required and Recommended Software
To configure and operate your multiviewer system, you need to have the following software 
installed on your local PC: 

 Layout Designer (see About Layout Designer on page 24)

 CCS Navigator (see About CCS Navigator on page 24)

To control and operate your multiviewer system using remote control options, we 
recommend that you have CCS Navigator installed on your local PC. CCS Navigator uses 
either its CCS-P protocol or SNMP to communicate with the multiviewer. You can also 
control and monitor the multiviewer using an SNMP third-party control system (see About 
Remote Control Systems on page 25). 

About Layout Designer
Layout Designer provides an integrated computer interface for the control and 
configuration of one or more multiviewer display systems over a LAN (local area network). 
These configuration options include:

 Changing the multiviewer’s IP address and Network Mask

 Setting output display mode

 Calibrating output display devices

Use Layout Designer to select layouts for display, select and change PiP input sources, and 
modify layouts and layout objects. Layout Designer also provides the tools to create and 
design new layouts and configure monitoring tools such as audio meters, tally indicators, 
and audio and video alarms. See your Layout Designer Software Application User Guide. 
See also Discovering Output Modules Using Layout Designer on page 36.

Layout Designer does not work with 64-bit operating systems. 

About CCS Navigator 
Use CCS Navigator to create a database that describes a routing system that includes your 
output module. This includes selecting the routing input sources that are to be available for 
routing to your output module for display. 

See Volume 6 of your Navigator User Manual for detailed descriptions of its installation and 
features. See also Adding Multiviewers to a Router Database on page 28.
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About Remote Control Systems
The HView SX Hybrid is fully compatible with CCS network control systems such as CCS 
Navigator and NUCLEUS Network Control Panel. With an optional license key upgrade, you 
can control and monitor the multiviewer using third-party SNMP software. You can 
remotely perform the following operations:

 Select and change layouts for display

 Select and change PiP input sources 

 Select audio channels for monitoring on the multiviewer’s AES outputs

 Monitor the multiviewer as well as audio and video signal alarms 

 Set audio and video alarm threshold values

 Change the output module’s IP Address and Subnet Mask

For more information about controlling the multiviewer using CCS control, see Controlling 
Your Multiviewer on a CCS Network on page 39. For detailed information about using 
NUCLEUS to control and monitor your multiviewer, see your NUCLEUS Multiviewer Control 
Option Configuration and Operation Manual. For information on controlling the 
multiviewer using SNMP software, see Controlling the Multiviewer Through SNMP on 
page 41. 

Updating Software and Firmware
Your multiviewer comes with all the software and firmware already installed. However, you 
may occasionally need to update some or all software or firmware components. 

The following sections outline individual components that can be updated: 

 Updating the Multiviewer Core Application on page 27

 Updating Layout Designer Software on page 28

You may also need to update the following non-multiviewer-specific software and firmware 
to enable features or functionality with multiviewer:

 Platinum (PT-RES) firmware (see your Platinum Installation, Configuration, and 
Operation manual for instructions)

 CCS Navigator (see your Navigator User Manual for more information) 

Determining Software and Firmware Versions
You may occasionally want to check software and firmware versions, to determine if 
updates are necessary, optional or even available. You may also want to check software and 
firmware versions, to ensure that updates were executed complete and correctly. 

To check your software and firmware versions, follow these steps: 

1 In Layout Designer, choose Tools > Advanced Configuration. 

2 Select the Version tab. 

To determine the firmware version, follow these steps: 

1 Open Telnet session with the IP Address of PT-RES module.
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2 Use the following to connect to the Telnet session:

Login: leitch

Password: leitchadmin

Type: ~showHW

A message similar to the following appears.

Output Cards

After the firmware had been updated, the frame must be re-polled again in CCS Navigator 
to show the proper firmware version.

Updating Multiviewer (PIPE) Firmware 

Do not update the Multiviewer PIPE firmware while the HView SX Hybrid 
application is running.

It is very important that you upgrade the Multiviewer’s XVIM PIPE firmware version to 1.8 or 
higher, and the PT-RES module to 3.3.b43 or higher.

1 Exit the Multiviewer application.

2 Start Navigator.

3 Select the Platinum frame, and then click Edit.

4 Select the Firmware tab.

5 Select the output module that is active in the frame (it has a little icon on the right).

6 Right-click the selected module, and then select Assign from the context menu that 
appears.

You can select multiple Multiviewers by holding down the CTRL key and clicking on each 
module.

7 In the list, select all of the output modules in a zone. 

Updating will not span zones. 

8 Right-click the selected module, and then select Change Firmware from the context menu 
that appears.

9 Browse to the RtrWrks/Bin32/Firmware folder and select the CENTRIO_xxxx.zip file.

10 Click Upgrade or Upgrade All and wait for a Firmware upgrade successful message.

Slot 1 Configured: CENTRIO-S Version 1.2 Family 003 Product Id 057

Detected: CENTRIO-S Version 1.8 Family 003 Product Id 057

Slot 2 Configured: CENTRIO-S Version 1.2 Family 003 Product Id 057

Detected: CENTRIO-S Version 1.8 Family 003 Product Id 057

Slot 3 Configured: CENTRIO-S Version 1.2 Family 003 Product Id 057

Detected: CENTRIO-S Version 1.8 Family 003 Product Id 057

Slot 4 Configured: CENTRIO-M Version 1.2 Family 003 Product Id 056

Detected: CENTRIO-M Version 1.8 Family 003 Product Id 056
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While the firmware is updating, the corresponding Multiviewer will restart twice.

Upgrading the Display Driver
1 Copy the install folder to USB memory stick and insert it into the output module’s USB port.

2 Double-click SETUP.EXE.

If the upgrade fails from USB memory stick, try again from USB or copying the folder on the 
multiviewer’s C: drive and double-click the SETUP.EXE file. 

The upgrade process may reset the display resolution. If the resolution is not restored when 
the Multiviewer application starts, then you may need to open the NVIDIA Control Panel 
and change the display resolution settings accordingly.

For 1080i:  select 1920 x 1200

For 720p:  select 1280 x 720

Upgrading Multiviewer Drivers and FPGA Firmware
1 Connect the USB mouse to the Multiviewer.

2 To exit the Multiviewer, right-click to open the Multiviewer Control Panel, and then click 
Explorer.

3 Browse to the location of the DriversFPGAs folder.

4 Double-click UpgradeAll.bat.

Four messages appear during the installation. Click Continue Anyway each time to 
proceed.

The H/W Upgrade dialog box appears. This upgrades XVIMs in parallel. 

5 When the first Flash file is updated, click OK to continue with the second Flash file update.

Once completed, the process will continue to update other software components and the 
computer will restart automatically. 

Updating the Multiviewer Core Application
You must uninstall the Multiviewer Core Application before installing an updated version. If 
you cancel the uninstallation process, you will not be able to install an updated version of 
the software. 

1 Browse to the location of the Multiviewer Core Application *.msi file (if using Windos XP) or 
*.exe file (if using Windows Vista), and then double-click the file. 

An Application Maintenance dialog box opens. 

2 Choose Remove, and then click Next. 

3 On the Multiviewer 3.x Uninstall dialog box, click Next to continue the uninstall process. 

A progress bar appears on the screen. 

4 When the uninstallation process is done, click Finish. 

5 Return to the location of the Multiviewer Core Application *.msi file (if using Windos XP) or 
*.exe file (if using Windows Vista), and then double-click the file again. 

A Welcome to the Harris Multiviewer 3.0 Installation Wizard dialog box appears. 

6 Click Next, and then follow the instructions that appear on the screen to install the 
updated version of the Multiviewer Core Application. 
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Updating Layout Designer Software
You must uninstall the Layout Designer software before installing an updated version. If you 
cancel the uninstallation process, you will not be able to install an updated version of the 
software. 

1 Browse to the location of the Layout Designer *.msi file (if using Windows XP) or *.exe file 
(if using Windows Vista), and then double-click the file. 

An Application Maintenance dialog box opens. 

2 Choose Remove, and then click Next. 

3 On the Layout Designer 3.x Uninstall window, click Next to continue the uninstall 
process. 

A progress bar will appear on the screen. 

4 When the uninstallation process is done, click Finish. 

5 Return to the location of the Layout Designer *.msi file, and then double-click the file again. 

A Welcome to Layout Designer 3.x Installation Wizard window appears. 

6 Click Next, and follow the instructions that appear on the screen to install the updated 
version of Layout Designer. 

Creating a Backup Settings Folder
The purpose of a Backup Settings folder on a multiviewer is to store a copy of the three key 
XML files as a backup. If the Multiviewer application detects any corruption in an XML file, 
it will copy the backup file from from the BackupSettings folder to replace the main file. If 
the file does not exist in the BackupSetting folder, then the Multiviewer application will 
create a new file with the default settings.

The three XML files are in the C:\Program Files\Harris\Harris Multiviewer folder:

 Settings.xml

 Configuration.xml

 Persistence.xml

Create a BackupSettings folder in the Harris Multiviewer folder. The path name will look 
like:

C:\Program Files\Harris\Harris Multiviewer\BackupSettings

Once you have completed configuring your multiviewer completely, copy the three XML 
files to the BackupSettings folder. 

Adding Multiviewers to a Router Database
After installing an output module in a Platinum router frame, you must configure a router 
matrix that includes your multiviewer output module. Using Navigator’s routing 
components, you can either create a new router matrix that includes your output modules, 
or you can add output modules to an existing routing matrix. Adding output modules to 
the routing matrix defines which router inputs will be used as input source audio and video. 
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The information below describes the different methods by which you can add an output 
module to a router database. It does not go into detail about any of these methods or 
about other aspects of editing a router database. For more information, please refer to the 
Volume 6 of your Navigator User Manual. 

To complete this task, you should have a working knowledge of Navigator.

Adding Output Modules by Polling
The Poll option queries the control system for any programmable devices present in the 
system. Polling obtains information about the current configuration of each physical device, 
and compares it to the information found in the database to determine if the database 
information matches the actual configuration. 

1 Start Navigator.

2 Right click on Routers in the Navigation pane, and then select Create > Routing System 
from the context menu. 

The New Routing System Configuration dialog box opens. 

Figure 3-2  Create Routing System Dialog Box

3 In the Name field, enter a name for the routing system.

This is the name that will appear in the Navigation window.

4 Under Create Options, choose Start from a blank configuration. 

This selection allows you to designate a new routing system, and then populate it manually 
or with a system poll.

5 Place a check beside Perform System Poll.

6 In the Connection field, choose TCP/IP, and then enter the IP address for your Platinum 
PT-RES module.

7 Click OK, and then wait while Navigator searches the network. 

When the search is complete, a series of folders appear under the name you provided in the 
Navigation pane. 
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Figure 3-3  Routers Folder in the Navigation Pane 

8 Right-click the Frame in the Routers folder, and then select Poll. 

Wait while Navigator polls the device. 

9 When the frame poll is complete, double-click the Frame in the Routers folder. 

The Edit Platinum Frame dialog box appears. 

10 On the Configured Matrices tab, click Add. 

The Add WB Matrix dialog box appears.

11 Under Matrix Type, select MultiView. 

The dialog box updates to display only multiviewer-related settings. 

Database Editor 

Frame icon
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Figure 3-4  Configuring HView SX Hybrid Matrix Settings

12 On the Add HView SX Matrices dialog box, do the following: 

a Under Multiview Type, choose HView SX Hybrid. 

b Under # HView SX Modules, select the number of installed HView SX Hybrid output 
modules. 

c Under Starting HView SX Slot, select the first slot in which the top-most HView SX 
Hybrid output module is installed. 

d Under # of Physical Ins, select 0. 

13 If required, make any changes to other settings in the dialog box, and then click OK.

In the Edit Platinum Frame dialog box, two different types of multiviewer selections have 
been added: HView SX Hybrid V for the underlying HView SX Hybrid video matrix, and 
HView SX Hybrid PIPs for the virtual HView SX Hybrid matrix. 

14 Multiviewers are placed in the graphical representation of the frame from the top down. To 
realign them in their correct positions, right click a module and select Unassign from 
HView SX V, and then click on the top row where the device should appear (HView SX 
Hybrid modules being four slots tall), right-click again, and select Assign to HView SX V. 

15 Select the range of video inputs to assign to HView SX Hybrid, then right-click and choose 
Assign to HView SX V. 

16 To add audio, right click on the audio inputs, and select Assign to HView SX V. 

17 To configure the level and output offsets (if required), highlight HView SX Hybrid V, and 
then click Advanced. 

The Matrix Partition dialog box appears. By default the output offset is equal to the size of 
the frame. 

18 Make any necessary changes to this screen, and then click OK. 

19 Highlight the same slots, right-click, and then select Change Format. 

The Select I/O Card Type dialog box opens. 
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Figure 3-5  Changing Audio Input Format

20 Under Format, select the correct audio format, and then click OK. 

This creates a HView SX Hybrid A audio matrix. 

21 Highlight the slots that contain audio input modules, and then right-click and select Assign 
to HView SX Hybrid V. 

Configuring Multiviewers in Database Editor
1 To open the Router Database Editor, double-click on the item inside the routing system’s 

Control Views folder. 

In this dialog box, you can make the following changes: 

 Configuring UMD names on page 32

 Configuring Discrete Audio Inputs on page 32

 Creating Destinations Representing Actual PiPs on page 34

 Setting Up PiPs to Follow Destinations on page 34

2 When your changes are complete, click Save, and then close the dialog box. 

3 Right-click the frame in the Routing system, and select Download. 

This loads the changes to the frame. 

Configuring UMD names
On the Sources tab of the Database Editor dialog box, change the contents of the Name 
column to change the UMD names of devices on the multiviewer. 

Configuring Discrete Audio Inputs
To map the video and audio, do one of the following: 
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 To configure discrete audio inputs in Stereo Breakaway mode (default), on the Sources 
tab, configure the audio logical IDs as in Figure 3-6. 

Figure 3-6  Logical ID Settings for Stereo Breakaway Mode with Discrete Audio Inputs

 To configure discrete audio inputs in RGB mode:

i. double-click the Frame in the Routers folder. 

The Edit Platinum Frame dialog box appears.

ii. Select the HView SX Hybrid A, and then click Advanced. 

iii. Under Partition Type select RGB/Stereo. 

iv. From the # of Partitions menu, choose the number of mono pairs of discrete audio 
per video. 

v. Assign the level of each component so that each pair is on its own level. 
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vi. In the Database Editor screen, click the Sources tab and configure the audio logical 
IDs as in Figure 3-7. 

Figure 3-7  Logical ID Settings for RGB Mode with Discrete Audio Inputs

vii. Click OK. 

Creating Destinations Representing Actual PiPs
1 Select the Sources tab in the Database Editor. 

Make sure the HView SX Hybrid video matrix (HView SX Hybrid V) and virtual matrix (HView 
SX Hybrid PIPs) are mapped to the same sources. 

2 Edit the PiP destinations as required. 

Information on different methods of editing your PiP destinations is included in Volume 6 of 
your Navigator User Manual.

3 Ensure that the correct destination names appear (or are assigned) to the correct control 
device(s). 

Setting Up PiPs to Follow Destinations
1 In the Database editor, click the Levels tab. 

The Edit Levels dialog box appears. 

2 Beside Destinations, choose the number of destinations you want the PiPs to follow. 

This will be less than the default. 
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3 Click OK. 

4 Double-click the Frame in the Routers folder. 

The Edit Platinum Frame dialog box appears. 

5 Highlight the HView SX Hybrid PiPs entry, and then click Advanced. 

The Matrix Partition dialog box appears. 

6 Change the Output Offset entry to 0. 

Click OK, and then OK again. 

7 On the Database Editor screen, click the Destinations tab. 

Check to make sure destinations are now mapped to Matrix 1, and to the HView SX Hybrid 
PIP Matrix. 

Now, when you switch a destination, you will not only switch the output destination, but 
also the source displayed on the PiP on HView SX Hybrid. This changes the PiP 1 parameter 
available in CCS Navigator or a NUCLEUS control panel. See PiP Parameters and 
Alarms on page 45 for more information. 

Configuring Salvos for use in Layout Designer 
You can create salvos within Navigator, and then create rules to trigger those salvos within 
Layout Designer or from the Multiviewer Onscreen Application. Follow these steps: 

1 Right click on Salvos under the Routing system you created for your HView SX Hybrid in 
the Navigation pane. 

2 select Create > Routing Salvo.... from the context menu.

The Salvo Editor opens. 

3 Click New. 

The Rename Salvo dialog box opens. 

4 Type a new name, and then click OK to save the name and close the window. 

Your salvo appears in the list at the left of the screen. 

You can now use the salvo editing tools to create your salvo. For complete information on 
the salvo editing tools, see your Navigator User manual or online help. 

5 When you are done creating salvos, click Publish to Devices. 

This sends the salvos and all other logical information, including the names.txt files,to 
applicable devices in the routing system. You can configure salvo triggering using Trigger 
Salvo and Change Salvo alarm actions in Layout Designer. See your Layout designer 
documentation for more information. 

Configuring Multiviewers in a Local Area Network
The default IP address for your output module is 192.168.100.250. You can use this IP 
address to connect your output module directly to Layout Designer or add the output 
module to your network. Once you have added the multiviewer to your network, you can 
change the output module’s IP address to suit your network requirements. 
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If you have more than one output module installed in your Platinum frame, you must go 
through the process of discovering and changing the IP address one output module at a 
time. 

Each multiviewer on the network must have an unique IP address. 

Configuring multiviewers on a local area network includes the following steps:

1 Discovering output modules using the default IP address. This may involve first configuring 
the Layout Designer PC to be on the same subnet as the multiviewers. See Adding the 
Multiviewer to the Layout Designer Devices List on page 37 and Preparing to Add 
Your Output Module to the Devices List on page 36.

2 Changing output modules’ IP addresses from their defaults to addresses that are within the 
range of the rest of your network. See Changing the Output Module IP Address on 
page 37.

3 Returning the Layout Designer PC to its original IP and subnet settings. See Returning the 
Layout Designer PC to its Original IP and Subnet Settings on page 39.

You can also use CCS Navigator to change the output module Ethernet 1 IP address. For 
more information, see Discovering Output Modules Using Navigator on page 40.

Output modules have two Ethernet connections: Ethernet 1 and Ethernet 2. Only 
Ethernet 1 is assigned the default IP address, so ensure that this port is used to connect 
your output module to the Ethernet port of your local PC or network connection or hub. 

Discovering Output Modules Using Layout Designer
You can discover an output module by adding its default IP address to Layout Designer’s 
Devices. You can connect Layout Designer to the output module, and then change the 
output module’s IP address.

After you discover the module, change its IP address using Layout Designer. If you have not 
yet installed Layout Designer on your local PC, do so now. See the Layout Designer Software 
Application User Manual for more information.

When you use the Discovery tool to add output modules to the device list, Layout Designer 
scans the network and reports all devices with an IP address. The amount of time required 
for discovery depends on the number of devices you have on your network. Layout 
Designer may discover devices that you do not want to add to the devices list.

Preparing to Add Your Output Module to the Devices List
Before adding an output module to the Layout Designer Devices list, ensure that it is 
connected to the Layout Designer PC.

The PC can be directly connected to the output module using an Ethernet cross-over cable, 
or directly connected to the same hub or switch as the multiviewer using a normal Ethernet 
cable. 

To connect your Layout Designer PC to an output module at its default IP address, follow 
these steps:

1 Make note of the IP address, subnet mask, and default gateway settings on your Layout 
Designer PC. 
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2 Change the network settings on your PC to the following:

 IP Address: 192.168.100.100

 Subnet Mask: 255.255.255.0

 Default Gateway: Blank

After you have configured the output module’s IP address for your network, you will need 
to return the PC to its original settings. See Returning the Layout Designer PC to its 
Original IP and Subnet Settings on page 39.

Adding the Multiviewer to the Layout Designer Devices List
1 Start Layout Designer.

2 From the application menu, select File > New > Configuration.

The Device Manager dialog box appears.

Figure 3-8  Entering the Multiviewer’s Default IP Address

3 Click Add Device. 

A new device appears in the Device list.

4 Under Device Name, you can enter a new name for the output module.

5 Under IP Address, type 192.168.100.250, which is the output mode default IP address. 

6 Under Display, enter the display number onto which your layouts will be published. 

In most configurations, the Display value should be set to 1. It can be set to 1 or 2 for Dual 
DVI and Dual SDI, and 1 to 4 for Quad SDI. 

7 To connect the output module to Layout Designer, click the Test button.

 If the connection is valid, the  icon is displayed under Connected. 

 If the connection is invalid, the  icon is displayed under Connected.

If your connection is reported as invalid, check the default IP address you entered, the IP 
address of your PC, and your Ethernet connections, and then click Test to test the 
connection again. 

8 After you establish a valid connection, click Save to save the list and connection 
information. You can change the IP address of your output module using Layout Designer’s 
Advanced Configuration dialog box. 

Changing the
Output

Module IP
Address

Use Layout Designer’s Advanced Configuration dialog box to change an output module’s 
IP address. (You can also use CCS Navigator to change your output module’s IP address. For 
information, see Discovering Output Modules Using Navigator on page 40.) 
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To change the output module IP address 

1 From the Device Configuration dialog box, click Advanced Configuration. 

The Advanced Configuration dialog appears. 

2 Under Device Name, select your new output module, and then click the IP Settings tab. 

Figure 3-9  Changing the Multiviewer’s Default IP Address

3 Under Ethernet 1, delete the information that appears in the IP Address and Subnet 
Mask fields, and then enter the IP Address and Subnet Mask that you want to use for the 
output module.

Leave all the fields of Ethernet 2 blank unless it is used to connect the multiviewer to 
devices on another LAN. If Ethernet 2 is going to be used, repeat step 3 for Ethernet 2, 
entering the different IP Address and Subnet Mask. 

4 If your multiviewer communicates with the PT-RES module through external cables, click 
ENET, and then enter the IP address of the PT-RES module. 

INET communicates with the PT-RES through the internal bus, and does not require you to 
enter IP address. 

5 Click Done.

Repeat the steps described in Adding the Multiviewer to the Layout Designer Devices 
List on page 37 and Changing the Output Module IP Address on page 37 for each 
output module that is installed in your Platinum router frame. When complete, you can use 
Layout Designer’s device discovery tool to add each output module to the Devices List. See 
Adding New Devices on page 39. 
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Returning the Layout Designer PC to its Original IP and Subnet 
Settings
If you changed your Layout Designer PC IP address to communicate with the output module 
at its default IP address, and you have successfully changed the output module IP address, 
you can now change the Layout Designer PC IP address, subnet mask and gateway settings 
to the original settings that you recorded in Preparing to Add Your Output Module to 
the Devices List on page 36.

Adding New Devices
After you have assigned your output module a unique IP address, you can use Layout 
Designer’s Discovery tool to add the output modules to the device list. Be aware that when 
you use the Discovery tool, Layout Designer scans the network and reports all devices with 
an IP address. The amount of time required for discovery depends on the number of devices 
you have on your network. Layout Designer may discover devices that you do not want to 
add to the devices list. 

Before attempting to discover your output module, ensure that you have returned your PC’s 
IP Address, Subnet Mask, and Gateway Address to their original network settings (see 
Returning the Layout Designer PC to its Original IP and Subnet Settings on page 39).

To discover output modules

1 On the Device Manager dialog box, under Device Discovery, click Discover Devices.

2 When the discovery is complete, do either of the following:

 To add specific devices, select the devices that you want, and then click Add to My 
Devices. 

 To add all of the discovered devices, click Add All to My Devices.

The selected devices are now in the Devices list. 

3 When you finish discovering and adding devices to the Devices list, click Save. 

You can now configure your multiviewer’s outputs. See Configuring Multiviewer 
Outputs on page 50 for more information.

Controlling Your Multiviewer on a CCS Network
You can use CCS Navigator and the NUCLEUS Network Control Panel to set CCS 
controllable parameters on your HView SX Hybrid. CCS parameters allow you to select 
layouts, modify some layout attributes as well as monitor feedback from multiviewers. 
Using CCS Navigator, you can also monitor various hardware alarms, such as operating 
temperature alarms, as well as monitor the integrity of audio and video input signals.

Each output module, system, and associated PiP has its own set of parameters and alarms. 
Before you can access these parameters and alarms, you must discover the output module 
using CCS Navigator. 

The following sections describe how to discover an output module and how to control and 
monitor it using CCS Navigator. For information about controlling output modules using 
NUCLEUS network control panels, see your NUCLEUS Multiviewers Control Option 
Configuration and Operation Manual.
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Discovering Output Modules Using Navigator
You can use CCS Navigator in Build mode to discover output modules that are connected to 
a CCS network. 

To discover a output module

1 Make sure Navigator is in Build mode by selecting File > Operational Mode > Build. 

2 If the Discovery Window is not open, click Tools > Discovery in the main menu. 

The Discovery Window appears, most likely in the bottom left corner of the screen. 

3 Click Options, and then click Add.

4 Enter the IP address of the output module you want to discover. 

5 Click OK to close the Add Host dialog box, and then OK again to close the Discovery 
Options dialog box. 

6 Click Start. 

Navigator runs a discovery. 

7 When your discovery is complete, Discovery Completed is displayed in the Discovery 
Window. 

8 Click Save. 

The contents of your discovery populate the Discovery folder of the Navigation Window. 

You can now switch to Control mode by selecting File > Operational Mode > Control 
from the main menu. Depending on which output module parameter set or alarm group 
you want to view, double-click on the appropriate icon in the Navigation Window to 
display the system, module, or PiP controls.

Figure 3-10 illustrates a discovered output module.

Figure 3-10  Discovering an Output Module

The following sections describe the multiviewer-related icons that appear in the Network 
view after you discover an output module.

Click this icon to expand the discovered HView SX Hybrid folder.

Discovered multiviewer 

PiP folder listing all of the PiPs 
associated with the currently 
active layout

Multiviewer module 
icon

Multiviewer system icon

Layout Designer start icon

1

2

3

4

5

1
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Double-click the HView SX Hybrid system icon while in Control mode to display 
the system-related parameters and alarms in a Control window. For information 
about system parameters and alarms, see Multiviewer System Parameters and 
Alarms on page 44.

Double-click the Layout Designer icon to start Layout Designer. For more 
information, see your Layout Designer Software Application User Guide.

Click the PiP icon to expand the PiP folder to display all the PiPs associated with 
the currently active layout. When in Control mode, you can double-click on the 
individual PiP icons to access individual PiP parameters and alarms in a Control 
window. For more information, see PiP Parameters and Alarms on page 45.

Double-click the HView SX Hybrid module icon to display the module related 
parameters and alarms in a Control dialog box. For information about module 
parameter and alarms, see Multiviewer System Parameters and Alarms on 
page 44.

Controlling the Multiviewer Through SNMP

Configuring a HView SX Hybrid as an SNMP Agent
You configure your multiviewer as an SNMP agent from Control Panel > Administrative 
Tools > Services (Local). 

1 Right-click on the display and select Exit Multiviewer to close the Multiviewer application. 

2 On th Multiviewer Control Panel window, click Command Prompt. 

3 Type the following: 

services.msc

The computer management Services dialog box opens. 

Figure 3-11  Services Dialog Box 

4 Under Services, right-click on the SNMP Service and select Properties. 

5 On the Traps tab, type a community name (usually Public). 

6 Click Add to List. 

2

3

4

5
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7 Click Add, and then type the IP address of the SNMP Manager unit in the Traps 
Destination field. 

8 Click Add, and then click Apply. 

9 Click OK. 

In the Computer Management Services window, the Status field should display SNMP 
Service Started. 

10 Click Start Multiviewer to restart the Multiviewer application. 

11 Click Launch Multiviewer. 

Configuring Third-Party SNMP Software Control
To set up your multiviewer with optional SNMP to communicate with SNMP MIB browsing 
software, follow these steps: 

1 Make the required network connections between the output module(s) and your PC with 
installed SNMP browser/control software. 

2 Ensure that your output module is configured to send traps to the computer that contains 
your MIB browsing software. 

3 For information on configuring SNMP on the output module, see Configuring a HView 
SX Hybrid as an SNMP Agent on page 41. 

4 Load the Leitch mibs (downloadable from our website) into your SNMP browser/control 
software: 

 leitch.mib

This MIB sets up the basic structure for product specific MIBs. It can be found under the 
Private > Enterprise branch in your MIB browsing software, and sets up the 
leitchProducts and leitchCommon sub-branches. 

The leitchCommon branch is initially empty. The leitchProducts branch contains 
several initially empty sub-folders.

 ccsAlarm.mib

This MIB adds a ccsAlarms sub-branch to the leitchCommon folder. When it is 
installed, you will be able to determine what specific module or frame has triggered an 
alarm (trap). 

These general MIB files set up a structure to help define parameters (as SNMP objects, 
and alarms as SNMP traps. 

5 Load the Multiviewer MIBs (downloadable from our website) into your SNMP browser/
control software: 

 MULTIVIEWERMODULE.mib

Loads the parameters and alarms listed in Multiviewer System Parameters and 
Alarms on page 44. 

 MULTIVIEWERSYSTEM.mib

Loads the parameters and alarms listed in Multiviewer System Parameters and 
Alarms on page 44. 

 PIP.mib

Loads the parameters and alarms listed in PiP Parameters and Alarms on page 45. 

The Multiviewer MIBs will appear in the (11) multiviewer folder under the LeitchProject 
folder.
pyright ©2011, Harris Corporation



HView SX Hybrid
Installation, Configuration, and Operation Manual

43
Figure 3-12  Multiviewer MIBs Loaded into NUDesign MIB Browser

6 Configure your MIB browser to connect to the output module by entering the IP address, 
Port (if you have changed the Port from its default in the configuration), and other standard 
configuration settings. 

Your browser should now connect to the SNMP agent running on the output module. 

7 To receive traps, start up the trap receiver in your MIB browser software. 

To verify that your configuration is correct, browse to Private > Enterprises > Leitch on 
the MIB tree, and then right click on the Leitch heading and choose Walk. 

You will see all the parameters and alarms for the device. 

To facilitate monitoring more than one multiviewer, MIBs index devices by IP address. These 
settings will be available in your SNMP manager. See your SNMP manager’s documentation 
for details of how to customize its configuration. 

Parameters 
and Alarms

Use CCS Navigator in Control mode or NUCLEUS network control panel to access CCS 
controllable parameters and alarms. Output modules have no card-edge controls. You must 
discover the output module before you can access CCS parameters and alarms (see 
Discovering Output Modules Using Navigator on page 40).

Output module alarms function in the same way other CCS device Smart Alarms operate. 
For information about how CCS Alarms work, see your CCS Navigator documentation. 
Additional audio and video alarms can be viewed on display layouts and with Layout 
Designer software. See your Layout Designer User Guide for more information about 
configuring and viewing on-screen audio and video alarms.
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Output module parameters and alarms are divided into the following Navigator Control 
Window tabs.

Figure 3-13  Multiviewer Devices That Launch Control Windows

Parameter Table Notes
The parameters are listed in the order that they appear in CCS Navigator.

When viewing the control parameter tables, observe the following:

 Shaded table rows indicate read-only (feedback) parameters. Some Read-only 
parameters can be modified using Layout Designer.

 Bold parameter options indicate the default settings for the parameter. 

Multiviewer System Parameters and Alarms
If your multiviewer has been configured for Independent mode (one layout for each DVI 
output display) using Layout Designer, two system icons appear in the Discovery folder. Each 
system has its own set of parameters alarms. To access the system parameters and alarms, 
in the Network view, click the multiviewer’s system icon, and select either the Parameters 
or Alarms tab. 

See the Multiviewers Configuration chapter in your Layout Designer Software Application 
User Guide for information on configuring for Independent mode.

Table 3-1 lists the system parameters, and Table 3-2 on page 45 lists system alarms. 

.

Each PiP has a separate control 
window. The contents are described in 
PiP Parameters and Alarms on 

Parameters for an individual output 
module (of which there are four) 
appear in Multiviewer Module 
Parameters and Alarms on page 49. 

Parameters for the multiviewer system 
as a whole appear in Multiviewer 
System Parameters and Alarms on 
page 44.

Table 3-1  Multiviewer System Parameters 

Parameter Name Function Options

Parameters

System Name Displays the name of the current Multiviewer system (displayed system name)

Active Layout Name Displays the name of the layout that is active on the 
selected system (lists all layouts stored on the 
Multiviewer module)

(name of currently active 
layout)
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PiP Parameters and Alarms
You can access PiP parameters and alarms for each PiP that is associated with a currently 
active layout. 

To access the PiP parameters and alarms 

1 In the Network view, double-click or expand the PiP folder. 

Each PiP associated with the layout is listed in the Network view. 

2 To access an individual PiP’s parameters, click the PiP icon, and in Control mode, click the 
Parameters tab. 

3 To view a consolidated list of PiP alarms, click the Alarms tab.

Table 3-3 lists the CCS parameters for each PiP. 

Number Displays Shows the number of display devices currently 
connected to the selected Multiviewer system

(number of displays)

Initial Counter Time Determines the start time of any counters (00.00.00.00)

Lock Display Disables on-screen controls on the output module  Disable 

 Enable 

Parameters > Virtual GPI

Virtual GPI (1-16) Renders the specified virtual GPI as active or inactive  Disable 

 Enable 

Table 3-1  Multiviewer System Parameters (Continued)

Parameter Name Function Options

Table 3-2  Multiviewer System Alarms

Alarm Name Description

System Major Summary Active if any alarm condition is reported 
(priority > 7) for the system

System Minor Summary Active if any alarm condition is reported 
(4 < priority < 7) for the system

System Communication 
Failure

Master module has lost connection to a slaved 
module

System LTC Failure System lost LTC input, if configured

System GPIO Failure System lost connection to external GPIO device, 
if configured

Table 3-3  PiP Parameters 

Parameter Name Function Options

Parameters

Name Displays the PiP name String (always shows PiP) 

Static Displays the label text on the selected PiP String (displayed label text)
Copyright ©2011, Harris Corporation



Chapter 3
Configuration and Operation

46

Co
Display Identifies which output display device is currently 
displaying the selected PiP

String (display name)

Dynamic Displays the source ID for the UMD source String (UMD source ID)

Source Name Selects the input source name for the PiP Drop-down list with all sources 
listed 

Source Number Displays the source number for the selected PiP Slider (1 to maximum source 
number) 

Source ID Displays the source ID for the selected PiP String (source ID)

Full Screen Enable Activates/deactivates full-screen view of the selected 
PiP

 Enable

 Disable 

Video Present Status Displays the presence of a video input signal on the 
PiP’s input source

(displays Absent or Present)

Video Standard 
Status

Displays the detected video standard of the PiP’s 
input source

(displays input standard status)

Aspect Ratio Displays the detected video aspect ratio of the PiP’s 
input source

(displays aspect ratio)

Test and Measurement 
(These parameters will not appear if your hardware does not support this feature) 

Color Source Sets the default color dislay to to From Video 
(color) or Monochrome (black and white)

 From Video 

 Monochrome 

Display Scope Determines what type of scope is displayed  None 

 Waveform 

 Waveform Parade 

 Line 

 Line Parade 

 Vector 

 Quad Display 

Video Line Select which line of the active video to evaluate (varies depending on input 
resolution) 

Zoom Range X Min Determines the start of the display, if you only want 
to view a portion of the video line

(varies depending on input 
resolution) 

Zoom Range X Max Determines the end of the display, if you only want 
to view a portion of the video line 

(varies depending on input 
resolution) 

Field Select Determines which video field (in interlaced formats 
only) 

 Even 

 Odd 

Audio Monitoring

AES Output Selects the AES output to configure for monitoring  AES 1 

 AES 2 

Channel 1 Selects which audio you want to output for audio 
monitoring in channel 1

1 to 16

Table 3-3  PiP Parameters (Continued)

Parameter Name Function Options
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Table 3-4 lists PiP alarms.

Channel 2 Selects which audio you want to output for audio 
monitoring in channel 2 

1 to 16 

Stereo Pair Selects which audio pair from the selected audio 
channel you want to output for audio monitoring 
(this control will set channel 1 and channel 2 
appropriately) 

 Channel 1 & 2 

 Channel 3 & 4 

 Channel 5 & 6 

 Channel 7 & 8 

 Channel 9 & 10 

 Channel 11 & 12 

 Channel 13 & 14 

 Channel 15 & 16 

Monitor Enables or disables audio monitoring  Disable 

 Enable 

PiP Location

X Offset Displays the offset value of the PiP’s horizontal (x) 
position in the layout

(offset value) 

Y Offset Displays the offset value of the PiP’s vertical (Y) 
position in the layout.

(offset value)

X Size Displays the value of the PiP’s horizontal (X) position 
in the layout.

 (value)

Y Size Displays the value of the PiP’s vertical (Y) position in 
the layout.

(value)

PiP State Indicates if the PiP is active in the layout  Disabled 

 Enabled 

Table 3-3  PiP Parameters (Continued)

Parameter Name Function Options

Table 3-4  PiP Alarms 

Alarm Name Description

Global Video Summary Active if any video alarm is reported

Global Audio Summary Active if any audio alarm is reported

Global Tally Summary Active if any tally alarm is reported

PiP Audio Ch 1 Missing  - 
PiP Audio Ch16 Missing 

An audio signal is not present on the PiP audio channel 
indicated (Ch1–Ch16).

PiP Audio Ch 1 Peak - 
PiP Audio Ch16 Peak

The audio level on the PiP audio channel indicated 
(Ch1–Ch16) is over the set peak threshold value.

PiP Audio Ch 1 Low - 
PiP Audio Ch16 Low

The audio level on the PiP audio channel indicated 
(Ch1–Ch16) is under the set low threshold value.

PiP Audio Ch 1 Silence - 
PiP Audio Ch16 Silence

The audio level on the PiP audio channel indicated 
(Ch1–Ch16) is under the set silence threshold value.

Audio Group 1 Missing - 
Audio Group 4 Missing

The specified audio group is not present.... 
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Format Change Indicates that the video input format has deviated from its 
defined standard

SD EDH Error Reports recurring EDH errors in the standard definition 
video signal

HD CRC Error Indicates that the internally calculated CRC value is 
different from the received CRC value 

Loss of Video Indicates that the multiviewer hardware can no longer 
detect a video signal from the video channel

CC Missing Indicates that closed captioning (can be HD or SD) is not 
present in the incoming video stream

CC Not Updating Indicates that closed captioning is not updating correctly 
in the incoming video stream 

WSS Missing Indicates that WSS is not present in the incoming video 
(should be present in SD625 only) 

Video Freeze Indicates that the input video image is frozen (static) 
according to user-defined frozen picture delay (duration), 
percent of frozen video in the frame, and amount 
difference between pixels percent tolerance 

Video Black Indicates that the input video image is considered a black 
picture according to user-defined percentage non-black 
picture, delay (duration), and black level threshold values

VChip Data Missing Indicates that there is no V-chip data in the incoming 
video stream

VITC Missing Indicates that there is no VITC in the incoming video 
stream 

CC Not Valid Indicates that the closed captioning data in the incoming 
video stream is not usable

Teletext Missing Indicates that there is no teletext in the incoming video 
stream

Teletext Not Updating Indicates that the teletext data in the incoming video 
stream is frozen

Teletext Not Valid Indicates that the teletext data in the incoming video 
stream is not usable

AFD Missing Indicates that AFD data is not present in the incoming 
video

AFD Format Change Indicates that the AFD information has changed from its 
previous format

Audio Format Change Indicates that the audio format has switched from Dolby 
D, Dolby E, or PCM, or indicates any format change 

Table 3-4  PiP Alarms (Continued)

Alarm Name Description
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Multiviewer Module Parameters and Alarms
Multiviewer module parameters and alarms apply to the output module hardware. To 
access the multiviewer module parameters and alarms, in the Network view, click the 
Multiviewer module icon, and select either the Parameters or Alarms tab. Table 3-5 lists 
the output module parameters and Table 3-6 on page 49 lists the output module alarms. 

.

Dolby E Program Change Indicates that the Dolby program format has deviated 
from the one specified

VChip Mismatch Indicates that the V-chip data in the incoming video 
stream does not match the expected rating 

WSS Format Change Indicates that the WSS information has changed from its 
previous format 

Table 3-4  PiP Alarms (Continued)

Alarm Name Description

Table 3-5  Output Module Parameters 

Parameter Name Function Options

Parameters

Module Type Displays the module type (displayed Master) 

System Name Displays the name of the current output module (displayed system name)

Table 3-6  Output Module Alarms 

Alarm Name Description

Major Alarm Summary Active if any alarm condition is reported 
(priority > 7) for the module. 

Minor Alarm Summary Active if any alarm condition is reported 
(4 < priority < 7) for the module. 

CPU Over Temperature The maximum operating temperature of the 
module’s central processing unit has been exceeded. 

GPU Over Temperature The maximum operating temperature of the 
module’s graphics processing unit has been 
exceeded. 

Main Board Over Temperature The maximum operating temperature of the 
module’s main circuit board has been exceeded. 

Storage Over Temperature The maximum operating temperature of the 
module’s storage device has been exceeded. 

Fan Unit 1 Failure Cooling Fan Unit #1 is not operating. 

Fan Unit 2 Failure Cooling Fan Unit #2 is not operating. 
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Configuring Multiviewer Outputs
Use Layout Designer to select which outputs you want to use to display layouts. You can 
access these options from the Advanced Configuration dialog box. 

Use these controls to select whether to output layouts to DVI or SDI output display devices. 
You cannot output layouts simultaneously to both DVI and SDI outputs. You can select from 
the following output display options:

 Redundant mode—Displays copies of a single layout on more than one output display 
device 

 Independent mode—Displays a single layout on a output display device

 Spanned mode—Displays a single layout across two output display devices

When you select spanned mode, you can also select either Horizontal or Vertical as a 
display orientation. 

DVI
Displays redundant, different, or spanned layouts on one or two 
monitors (options are displayed in Table 3-7) 

SDI
Displays redundant, different, or spanned layouts on up to four monitors 
(options are displayed in Table 3-8 on page 51)

Table 3-7  DVI Output Display Configurations 

Output Video Setting Display 

Redundant DVI

Spanned DVI 

Dual DVI

Layout 1 Layout 1

DVI 1 DVI 2

Layout 1

DVI 1 DVI 2

Layout 1

DVI 1 DVI 2

Layout 2
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Spanned DVI Vertical

Quad DVI (requires two Matrox 
TripleHead2Go boxes; see page 21) 

Table 3-7  DVI Output Display Configurations (Continued)

Output Video Setting Display 

Layout 1

DVI 1

DVI 2

DVI 1 DVI 2

DVI 3 DVI 4

Layout 4Layout 3

Layout 2Layout 1

Table 3-8  SDI Output Display Configurations 

Output Video 
Setting Display Output Video 

Setting Display 

Redundant SDI Quad SDI 

SDI 1 SDI 2

SDI 3 SDI 4

Layout 4Layout 3

Layout 2Layout 1

Layout 1 Layout 1

Layout 1

SDI 1 SDI 2

SDI 3 SDI 4

Layout 4Layout 3

Layout 2Layout 1
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Configuring Outputs With Layout Designer
You can use Layout Designer to select which outputs you want to use to display layouts as 
well as select an Output Display mode for your output display devices. 

You must be familiar with the operation of your Layout Designer software application. For 
more information, see your Layout Designer Software Application User Guide.

Before using Layout Designer to configure your outputs, you must perform the following 
tasks:

 Install Layout Designer on a local or network PC (see your Layout Designer Software 
Application User Guide)

 Add your multiviewer to a router database (see Adding Multiviewers to a Router 
Database on page 28)

 Change the default IP address of your multiviewer (Configuring Multiviewers in a 
Local Area Network on page 35)

 Discover your multiviewer output module (see Discovering Output Modules Using 
Layout Designer on page 36)

To configure your outputs

1 Start Layout Designer.

If a message appears telling you that Layout Designer cannot connect to your multiviewer, 
check your system Ethernet connection, and then rediscover your multiviewer (see 
Discovering Output Modules Using Layout Designer on page 36).

2 In the Multiviewer panel, right-click on a connected HView SX Hybrid, and then select 
Advanced Configuration from the context menu.

3 From the Advanced Configuration dialog box, click the Display tab.

4 Under Video Output, select SDI or DVI.

The row of options will update to reflect the monitor configurations that are available (see 
Table 3-14 and Table 3-15).

Spanned SDI Dual SDI 

Table 3-8  SDI Output Display Configurations (Continued)

Output Video 
Setting Display Output Video 

Setting Display 

SDI 1 SDI 2

SDI 3 SDI 4

Layout 1

Layout 1

Layout 2

SDI 1 SDI 2

SDI 3 SDI 4
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Figure 3-14  Selecting Video Output Settings for DVI 

Figure 3-15  Selecting Video Output Settings for SDI 

You cannot output layouts simultaneously to both DVI and SDI outputs. 

5 If you selected a DVI video output setting, select an output resolution from the DVI 
Resolution drop-down list. If you selected an SDI video output setting, select an output 
resolution from the SDI Standard drop-down list. 

6 Click Done.

For information on the Test Signal and Timing options on this screen, see your Layout 
Designer Software Application User Guide. 

Configuring Multiviewers for Router Follow
With destination router follow, you can configure a PiP to follow a particular destination 
within the router database. 

Configuring Specific PiPs for Router Follow
1 In Layout Designer, open an existing layout, or create a new layout. 

2 Select a PiP in the layout that you want to router follow. 

3 Check Follow Destination in the PIPs properties tab, and then in the field to the right, 
enter the number of the router destination for the PIP to follow. 

4 (Optional) Check the box beside Virtual for virtual destinations. 

Virtual outputs need to exist in the router database. See Configuring Virtual 
Destinations for Router Follow in a Router Database on page 53. 

Configuring Virtual Destinations for Router Follow in a Router 
Database
To add virtual destinations to a router matrix, follow these steps: 

1 In Navigator, double-click the Frame in the Routers folder. 

The Edit Platinum Frame dialog box appears. 

2 On the Configured Matrices tab, select the matrix to add the virtual output module(s).
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3 Right-click an empty output location in the frame and select Assign to. 

You can add outputs that are not physically present in the frame, for example destinations 
numbered higher than the number of actual destinations in the matrix. 

Tieline
Support

To enable support for tielines in the HView SX Hybrid, follow these steps: 

1 Open the settings.xml file in C:\Program Files\Harris\CENTRIO directory.  

2 Find the following line: 

<enableRemoteSources>false</enableRemoteSources>

3 Edit this line from false to true as follows:

<enableRemoteSources>true</enableRemoteSources>

4 Save the change and restart the HView SX Hybrid.

This change will allow the HView SX Hybrid access to tieline sources from upstream routers.  
These sources can now be assigned to PIPs in Harris Layout Designer or in the Select Video 
Source option of the On-Screen Menu.  Alternatively, PIPs can be configured for destination 
follow and the tieline sources assigned through an external control panel. 

If there are no tielines available, the PIP will show one of the following:

 If the tieline sources are assigned to the PIP through Layout Designer or switched using 
the on-screen menu, then a "No Signal" message will appear on the PIP. 

 If the PIP is configured for destination follow and routed to a tieline source, then the PIP 
will keep the signal that was present before the route request to the new tieline source.

Configuring JLCooper eBOX in Layout Designer 
You can use JLCooper eBOX units to add GPIO functionality to your HView SX Hybrid. For 
information on connecting a JLCooper eBOX, see External Hardware Components on 
page 9 and the documentation that came with the unit. 

The first JLCooper eBOX that is connected to the multiviwer using Ethernet must be set up 
as a server, and any following eBOX devices should be configured as clients. Information on 
configuring clients and servers is included in your JLCooper eBOX documentation. 

To configure your multiviewer to communicate with the JLCooper eBOX, follow these steps: 

1 Right-click a device in the Multiviewers window, select Advanced Configuration, and 
then click on the External Devices tab. 

2 (Optional) In the Name field, enter a name for the device. 

3 Under Type, select JL Cooper E-Box. 

4 Under Port, select TCP/IP. 

The right side of the dialog box may update to display IP settings. 

5 Under IP, enter the IP address of the JLCooper eBOX. 

192.168.254.102 is the default IP address. Depending on the way your eBOX is connected 
to the multiviewer, you may need to change this so both devices are on the same subnet. 
This is not necessary if they are connected directly using an Ethernet cross-over cable. See 
your eBOX Users Manual for information on changing the device’s IP address. 
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6 Under IP, enter the IP Port of the JLCooper eBOX. 

The default port is 23. 

7 Click Add. 

The JLCooper eBOX appears in the table below the Add button. 

8 Click Done to close the Advanced Configuration dialog box. 

Configuring the Multiviewer to share JLCooper eBoxes
You can connect up to four eBoxes to a multiviewer output module, providing up to 96 GPI/
O triggers. 

Figure 3-16  Connecting Multiple eBoxes to a Single Multiviewer

1 Configure a multiviewer to connect to multiple eBoxes, following the steps in Configuring 
Multiviewers for Router Follow on page 53. 

2 Configure a second multiviewer to connect to an eBox as in Step 1, with the following 
changes: 

 Use the IP address of the multiviewer configured in Step 1. 

 Use IP port 49153. 

3 To configure each additional multiviewer to connect to a multiviewer configured with an 
eBox, increment the IP port number by one each time (port 49154, 49155, and so on). 

To configure eBox server port, edit the settings.xml eBoxServerPort on the multiviewer that 
has the eBox physically connected. 
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 eBOX1 = GPI/O 01~24
 eBOX2 = GPI/O 25~48

IP: 192.168.100.101
Port: 23

IP: 192.168.100.102
Port: 23

192.168.100.10
Copyright ©2011, Harris Corporation



Chapter 3
Configuration and Operation

56

Co
Configuring Multiple Multiviewers to Multiple JLCooper eBoxes
You can connect multiple multiviewers to up to four JLCooper eBoxes. 

Note: The EBoxServerPort parameter in Settings.xml file defines the base starting port 
number. This parameter setting is only applicable to the master multiviewer. 

Figure 3-17  Multiple JLCooper eBoxes Connected to Multiple Multiviewer Devices 

1 On the Advanced Configuration > Ext. Devices Tab, configure the master multiviewer to 
point to all eBOXes using the port defined in the EBoxServerPort parameter in the 
Settings.xml file. 

The default is 23. In Figure 3-17, the master multiviewer points to three eBoxes on port 23. 

2 On the Advanced Configuration > Ext. Devices Tab, configure the slave multiviewers to 
point to the master multiviewer using the starting port number (port 49154, 49155, and so 
on). 

The slave multiviewer’s port number automatically increments by one for each eBOX 
configured. 
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eBOX1 = GPI/O 01~24
 eBOX2 = GPI/O 25~48
 eBOX3 = GPI/O 49~72
 eBOX4 = GPI/O 73~96 (Max)

IP: 192.168.100.101
Port: 23

IP: 192.168.100.102
Port: 23

192.168.100.11

192.168.100.12

IP: 192.168.100.103
Port: 23

192.168.100.13

Multiviewer #1 (Master )

Multiviewer #2 (Slave)

Multiviewer #3 (Slave)
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4 On-Screen Controls
About 
On-Screen 
Menus

Once you have published your layouts, each multiviewer provides you with access to 
on-screen menus. 

You can use a mouse connected to your multiviewer to access certain features using control 
menus. For example, you can make a PiP go full screen, clear an alarm condition, or view PiP 
information. Alternatively, you can access the same control menus remotely from a 
computer that is running Layout Designer.

You must have a mouse connected to your multiviewer to be able to use the on-screen 
menus. Alternatively, you can activate the remote mouse control from Layout Designer.

Use your mouse to right-click on an object or the background in the layout. A menu appears 
with different items, depending on where you have clicked. Table 4-1 lists the various 
options that might appear. 

When you reach the end of a menu, it will restart again at the beginning. 
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Table 4-1  On-Screen Menu 

Item
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Description

Select Video Source X Lists of all the possible PiP sources. This allows you to assign a 
different source to the selected PiP. 

Full Screen X Causes the PiP to expand to the size of the screen. To turn off 
the full screen view, right-click the PiP, and then choose 
Revert to Layout.

PiP Information X Lists attributes for the selected PiP, including 

 Source 

 URL 

 Stream width (pixels) 

 Stream height (pixels) 

 Stream aspect ratio 

 Video Format 

 On-screen width (pixels) 

 On-screen height (pixels) 

This information can be useful for troubleshooting purposes.

Monitor Audio X  Choose the audio to monitor from a list of all the discrete 
and/or embedded audio options that are available for that 
window. Note: You cannot monitor audio from an IP source. 

Disconnect VNC X PiP image reverts to a “no signal” picture (VNC PiPs only)

Connect VNC X Attempts to reconnect a PiP to a VNC server (VNC PiPs only)

Send CTRL+ALT+DEL X Opens the Windows Security dialog box on the VNC server, 
so you can lock the computer, restart, etc. (VNC PiPs only)

Display Scope X When Test and Measurement is available, this item displays a 
sub-menu that lists all the different modes that available for 
Test and Measurement. When you choose one, the PiP 
changes to display that option. If another PiP is currently 
displaying a scope, that PiP will revert to its previous mode. 

Color Source X This item is appears on the on-screen display menu when 
Test and Measurement has been activated. Choose 
Monochrome to display the results in black and white, or 
From Video to display the results in the actual colors from 
the video.

Select Audio Source X Scroll and select from list of available audio sources

Audio Information X Displays source number and name, audio format type, and 
the audio channel that is being mapped to the audio meter

Reset Alarms X X Clear an alarm state. (You can also clear alarms on the Layout 
property pane in Layout Designer.) 
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Remote
Mouse

Control

If you do not have a mouse connected do your multiviewer, but you want to access the 
on-screen menus, you can activate remote mouse control from the computer that is 
running Layout Designer.

When this feature is activated, the mouse appears on the output display currently selected 
in Layout Designer. You cannot use the other features of Layout Designer until you 
deactivate the remote mouse control. 

Enable Detectors X X When you choose this item, all of the alarm conditions that 
you defined for that PiP appear. You can select or clear 
(deselect) any conditions that appear in the list. If you did not 
define any alarm conditions for the selected PiP, none is 
listed.

Enable Alarms X X When you choose this item, all of the alarm detectors that 
you defined for that PiP appear. You can select or clear 
(deselect) any detectors that appear in the list. If you did not 
define any alarm detectors for the selected PiP, none is listed.

Recall Layout X X X X Lists any layout that was published previously and allows you 
to select one to display.

A
d

v
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n
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d

Lock Display X Disables the display from accidental change of the layout. 
Recall Layout is not available when the display is locked. 

Clear Messages X X X Acknowledges messages displayed by alarm rule message 
box. (You can also clear messages on the Layout property 
pane in Layout Designer.) 

Reset layout X X X X Disconnects all PiP sources for all displays and requires the 
user to recall all layouts

Reset and Recall 
Layouts

X X X Disconnects all PiP sources for all displays and recalls all 
layouts automatically 

Run Performance 
Tests

Diagnostic tool to run a performance test for debugging 
purposes. The results of the test are saved to a file named 
PerformanceLog.txt in the folder c:\Program Files\Harris\Harris 
Multiviewer. 

Send Serial Break Diagnostic tool to send a break command when using Sony 
Tally protocol. 

Enable Metadata 
Debug

Diagnostic tool to capture metadata for debugging purposes.
. 

Exit Multiviewer X X X X Exits to the Multiviewer Control Panel.

Table 4-1  On-Screen Menu (Continued)
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To activate remote mouse control:

1 In Layout Designer, click Enable Control.

Figure 4-1  Location of the Enable Control Button

The mouse appears on the corresponding multiviewer. The other features of Layout 
Designer are unavailable.

To deactivate remote mouse control:

1 On the keyboard, press ALT + F7.

Controlling a
VNC PiP

For information on creating VNC PiPs, see Selecting a PiP’s Input Source on page 110.

To take control of a VNC PiP: 

1 Left-click inside the PiP. 

To control a VNC clip from the multiviewer, your keyboard must be US English 101 key. 
Some special key sequences may not work. 

To release control of a VNC PiP: 

1 Do one of the following: 

 Hold down the left mouse button and then double-click the right mouse button. 

 On the keyboard, Press ALT+F7. 

Controlling a
Counter

To control a counter using on-screen controls on the  HView SX Hybrid multiviewer, follow 
these steps: 

1 Right-click on a counter. 

2 Use the following controls: 

Start - updates the counter to proceed with the linear countdown 

Stop - stops and reports the current countdown time until further notice 

Reset - re-initializes the counter using the original start, stop, blink, and alert times. Any 
rules that were active in the layout will still trigger the counter the same way as before. 

Using the Multiviewer Web Interface
You can use the Multiviewer Web interface to perform the following functions: 
pyright ©2011, Harris Corporation



HView IP
User Guide

61
 Add users and control their access to aspects of the device 

 Choose layouts on a display

 Change the source of PiPs in a layout

 Import and edit labels in a layout

If your browser does not have Silverlight installed, when you enter the IP address for the 
HView SX Hybrid Multiviewer, a page opens with a link to install Silverlight. Follow this link 
to download the installer, and then follow the instructions that appear on the screen. 

If the PC does not have a valid Internet connection, download the installer from http://
silverlight.net/getstarted/silverlight3/. 

Starting the Multiviewer Web Interface
To start using the Multiviewer Web interface, follow these steps: 

1 Type the Multiviewer’s IP address in your internet browsing software. 

A Login dialog box appears. 

2 Enter your login ID and password. 

The default login ID is Admin, and there is no password associated with this login ID. 

3 Click OK. 

4 A screen similar to the following appears:

Figure 4-2  Multiviewer Web Interface

5 In the Displays section at the right of the screen, choose the display you would like to view. 

The main portion of the screen updates to show the layout that is currently assigned to that 
screen. 
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At the top of the screen, drag the slider to the left and the right to make the layout larger 
and smaller, or click Fit to adjust the layout to the available screen area. 

You can view any PiP as full-screen on the Multiviewer by clicking Toggle Full Screen. 
Return to the normal layout display by clicking the same button again. 

Controlling User Access to the Multiviewer Web Interface 
1 Click Settings. 

The Settings Dialog opens. 

Figure 4-3  Multiviewer Web Interface Settings Dialog Box

2 Under User List, click Add. 

A row is added in the User List table. 

3 In the User Name field, enter a name. 

4 In the Password field, enter a password for this user, and then enter the same password in 
the Confirm Password field. 

5 For each display available at this IP address, place a check if you want this user to have 
access. 

(Scroll to the right to see all the displays). 
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Two other options are also available on a per-user basis: 

 Enable Control–Allows this user to control the selected displays. When unchecked, 
the user can view displays but not alter labels, PiP sources, etc. 

 Allow Settings–Gives this user administrative privileges. 

6 Click OK. 

Choosing a Layout 
Under Layouts in the right of the screen, click the drop-down menu to choose a layout. 

Display Layout–Sends the layout to the Multiviewer. 

Preview Layout–displays a preview of the layout on the Multiviewer Web interface screen. 

Changing PiP Sources in a Layout
You can change the source for any PiP by right-clicking on that PiP in a layout and choosing 
a new source from the menu that appears. 

Importing and Editing Label Text
When you select the Label properties pane option External Update (External Number) 
for a label in Layout Designer, the label can receive data from the Multiviewer Web 
interface.

1 On the Multiviewer Web interface, click Import File. 

The Label Updates dialog box appears. 
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Figure 4-4  Label Updates Dialog Box 

2 Click Import Label File, and then browse to the location of the *.csv file. 

*.csv files can be created in Microsoft Excel. Your Excel file will normally have four columns, 
with contents to match the above figure, and a row for each label. 

3 Click OK to import the label file. 

The table updates to display all label text. 

To make any necessary changes to the content of the label file, you can click in a field and 
then type new data. 

Data in the table needs to be in the following format: 

If you build the data in another program, columns of data should be separated by commas, 
and each row of data should end in a carriage return. 

Table 4-2  Label Update Contents

Column Contents

IP address The IP address of the Multiviewer 

Display Number The number of display that the label is 
displayed on 

Label Number The number set by the label properties

Message The text that appears in the label
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4 Click Update All Labels to update the layout as it is displayed on the Multiviewer Web 
interface. 

5 Click OK to close the Label Updates dialog box. 

6 On the main Multiviewer Web interface, click Update Labels to send the changes to the 
Multiviewer display. 

Editing Label Text Manually 
1 On the main Multiviewer Web interface screen, click a label. 

2 Enter text using a standard keyboard. 

Click Update Labels to send the changes to the Multiviewer display. 

Using the Multiviewer Control Panel
Administrator users of the multiviewer may need to use the Multiviewer Control Panel to 
perform maintenance operations. To access the Multiviewer Control Panel, you must exit 
the multiviewer from the On-Screen menu.

Accessing the Multiviewer Control Panel
1 Select Exit Multiviewer from the On-Screen menu, and then click Yes to confirm.

A dialog box similar to the following appears. 

Figure 4-5  Multiviewer Control Panel 

2 Click Enable to enter Maintenance mode. 

The Disable becomes Enable, and all the buttons in the Actions section of the screen will 
be unavailable. 
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With Maintenance mode enabled, the following actions will be available: 

Configuring Start/Stop Options 
Once you have the Multiviewer application open, you can control options for the 
Multiviewer OnScreen Application. The same dialog box has a button to restart the 
onscreen application, as well. 

1 On the Multiviewer Control Panel, click Enable. 

2 Click Start Multiviewer.

The Configuration dialog box appears.

Table 4-3  Multiviewer Control Panel Options 

Button Function

Maintenance Mode  Enable—Sets the Control Panel to maintenance mode

 Disable—Sets the Control Panel to normal operation mode 
(from maintenance mode)

Status Indicate green when Multiviewer Monitor and Multiviewer 
are functioning, red when they are not. 

Stop/Start Multiviewer Opens a dialog box that contains startup options, and also 
contains buttons to relaunch the Multiviewer On-Screen 
Application; see Configuring Start/Stop Options on page 66

Device Manager Loads the Windows Device Manager application (this is the 
same device manager that you could launch by selecting Start > 
Control Panel > System > Hardware > Device manager). 
Administrators might use this screen to manually configure 
devices. 

Explorer Starts the standard Windows file system explorer application, 
opened to the Harris Multiviewer folder where layouts, etc. are 
stored 

NVIDIA Control Panel Starts the NVIDIA application to configure the NVIDIA graphics 
drivers settings, including color temperature, screen alignment, 
etc. See your NVIDIA documentation for information on the 
various panels and wizards involved in this tool. 

Command Prompt Starts the command prompt application, from which you can 
ping other devices on the network to troubleshoot 
communications issues, etc. 

Set Time/Date Opens a standard Windows Date and Time Properties dialog 
box (also accessible by right-clicking on the time and date that 
are normally present in the bottom right corner of a PC). 

Acquire New Display  Sets your multiviewer temporarily from SDI mode to DVI mode 
for diagnostic purposes (a restart is required); restart the 
multiviewer again to return to SDI mode 

Logs Opens Internet Explorer and displays the Harris Logging Server; 
see Using Multiviewer Logs on page 68

Shutdown System Shuts down the PC and does not restart 

Restart System Shuts down and restarts the PC 
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Figure 4-6  Configuration Dialog Box

Table 4-4  Configuration Dialog Box Options 

Option Function

Load last layout on 
startup

When this is checked and the multiviewer starts up, it will reload 
the layout that was displayed when you last exited

Save source 
changes to layout

When this is checked, after you change inputs to the PiPs (for 
example using CCS controls or NUCLEUS), these changes are saved 
to the layout, and are reloaded if the layout is loaded again. 
When this is not checked and you make changes to the layout, 
when the layout is reloaded, it will revert to its original inputs. 

Force Display 
Adapter Settings 

This option should always be checked during normal operation. 
When it is not checked, the display settings may not be respected 
by the display device. 

Show Advanced PiP 
Information

This is normally used for diagnostic purposes, and includes the 
XVIM ID that PiPs are coming from, and their input source

Show CPU Meter Shows the percentage of the CPU power that is currently in use; 
this option is normally not checked

Output to Window Outputs the layout configuration to a window (as defined by the 
Height and Width fields) on your screen; this option is normally not 
checked 

LTC Input Format Used when configuring the clock reference signal; options include: 

 Leitch 12M

 SMPTE 12M 

 SMPTE 309
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3 Click Launch Multiviewer to start the Multiviewer application and its On-Screen menu. 

Click Apply to save your System Startup settings, Revert to reset the content of the 
Configuration dialog box, or Cancel to cancel launching the Multiviewer application.

Restarting the Multiviewer Control Panel
If you accidentally closed the Multiviewer Control Panel, you can reopen it. 

1 Simultaneously press the CTRL, ALT, and DEL keys on your keyboard. 

The Windows Security dialog box opens. 

2 Select Task Manager.

3 The Windows Task Manager dialog box opens. 

4 From the application menu, select File > New Task (Run)…

A Create New Task dialog box opens. 

5 Click Browse, and navigate to C: > Program Files > Harris > Harris Multiviewer. 

6 Double-click on XenaShell.exe, and then click OK.

The Multiviewer Control Panel appears. 

Unlocking the Multiviewer Display
If you accidentally locked the Multiviewer display, you can unlock it.

1 In the Unlock Computer dialog box, enter the following settings:

 User Name: Administrator 

 Password: (your Multiviewer Administrator user password) 

By default, this password is set to Centrio. Note that these fields are case sensitive. 

2 Click OK. 

Changing the password is not recommended. If you change the password, you will be 
prompted to enter it every time the multiviewer is restarted. 

Using
Multiviewer

Logs

When you click the Logs button on the Multiviewer Control app, Internet Explorer opens 
and displays a screen similar to the following: 
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Figure 4-7  Logging Server (as Viewed in Internet Explorer 8) 

Separate logs are created for the following items: 

 Multiviewer—Logs hardware faults. 

 Multiviewer Monitor—Logs display and software faults. 

 ccspinterface.ccssnmp—Logs alarms and traps sent to CCS and SNMP devices. 

Table 4-5  Logging Server Options  

Option Function

S
e

tt
in

g
s Quota Management This screen indicates the current and maximum size of 

the log file, and offers the opportunity to change the 
maximum size. When a log reaches its maximum size, a 
new log file is created on the server. 

To
o

ls
 

Save Logs Place a check beside each log type you want to save, 
enter a location to save the logs to, and then click Save 
Logs. By default, logs are saved locally to c:\LogFiles on 
the multiviewer. THe log file name is Logs.harrislog. A 
Harris Log explorer software is used to view these logs.

Export Logs to Text Place a check beside each log type you want to export, 
enter a location to save the logs to, and then click 
Export Logs. Logs are exported as TXT files for 
debugging purposes. 

Download all Logs Downloads all the logs from all application profiles. 

Delete Logs Place a check beside each log type you want to delete, 
and then click delete Logs. 
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Multiviewer Each of these three screens offers a list of log files saved 
for that item. 
The Assert Verbosity menu contains several levels:

 Assert

 Fatal

 Critical

 Error

 Performance

 Warning (default) 

 Info 

 Debug 

The verbosity setting determines the number of alarms 
you will receive and therefore the size of the log file. 
You can also filter on these options within the Log file 
viewer. 

Multiviewer Monitor 

ccspinterface.ccssnmp

Processes 

Table 4-5  Logging Server Options (Continued) 

Option Function
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5 Specifications
IP Inputs and Performance
I

Note: Multi-program content can only be monitored from one IP address stream at a time. 

Linear Time Code Input

Table 5-1  IP Inputs and Performance

IP Video Compression Number of Baseband PiPs

Profile/Level up to Max bit 
rate (Mbps) 0 8 16 24 30

N
u

m
b

e
r 

o
f 

IP
 P

iP
s

720x480 or 720x576 MPEG-2 
MP@ML 

5 5 4 4 0 0

720x480 or 720x576 MPEG-2 
MP@ML 

2.5 6 6 5 4 0

720x480 or 720x576 MPEG-2 
MP@ML 

1.5 8 7 6 5 4

1280x720 MPEG-2 MP@HL 22 1 1 1 1 1

1280x720 MPEG-2 MP@HL 7 2 2 2 1 1

1920x1080 MPEG-2 MP@HL 18 1 1 1 0 0

1920x1080 MPEG-2 MP@HL 13 1 1 1 1 1

H.264 MP@level 3 0.61 5 5 4 0 0

Table 5-2  Balanced Longitudinal Time Code

Item Specification

Standards (compatible)  SMPTE 12M-1999 

 SMPTE 266M-2002

Connector type 3-pin LTC 

Impedance Hi-Z (>30 k

Input sensitivity 100 mV pk-to-pk 
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HD-SDI 
Outputs

Table 5-3  Layout Designer HD-SDI Output Specifications 

Item Specification

Number of outputs 4 

Standards (compatible)  SMPTE 259M

 SMPTE 292M

 SMPTE 424M

Frame rates  1080i50

 1080i59.9

 720p50

 720p59.9

Connector type C per IEC 169-8

Impedance 75

Return loss >15 dB (typical) to 1.485 GHz

DC offset 0.0 V ± 0.5 V

Signal level 800 mV ± 10%

Rise and fall time <270 ps at 1.485 GHz

Overshoot <10% of amplitude

Jitter  Timing (<1 UI at 1.485 GHz)

 Alignment (<0.2 UI at 1.485 GHz)
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Supported Video Output Resolutions

Supported DVI output resolutions are subject to the capabilities of the connected DVI 
display. Support cannot be guaranteed for displays with non-standard timing..

1For these resolutions, the multiviewer hardware supports both 50 Hz and 60 Hz output. 

2These resolutions are not available in Quad SDI mode. 

Audio Compression Formats 
 MPEG-1 Layer 2 (Musicam) audio 

 Dolby AC-3 audio 

 AAC and HE-ACC audio 

Table 5-4  Supported Output Resolutions 

DVI Output Resolution SDI Standard

When Redundant DVI, spanned DVI, Dual 
DVI, or Spanned Vertical DVI is chosen

 1080i @ 50 Hz 

 1080i @ 59.94 Hz 

 720p @ 50 Hz

 720p @ 59.94 Hz

 SD 525 59.94

 SD 625 50

 1080p @ 59.94 Hz2 

 1080p @ 50 Hz2 



 1024 × 768  

 1024 × 800

 1152 × 864

 1280 × 720

 1280 × 768 

 1280 × 800

 1280 × 960

 1280 ×1024 

 1344 × 840

 1440 × 1050

 1440 × 900

 1440 × 1080

 1600 × 900

 1600 × 1024

 1600 × 1200 

 1680 × 1050 

 1792 × 1344

 1856 × 1392

 1920 × 1080

 1920 × 1200 

 1400 × 1050 

When Quad DVI is chosen

 1280 × 720 

 1024 × 768 

 1440 × 900

 1280 × 1024
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AES 
Monitoring 
Output

DVI 
Outputs

USB I/O

Table 5-5  Layout Designer AES Monitoring Output Specifications 

Item Specification

Standards AES3, SMPTE 276

Type Unbalanced, AC coupled

Connector BNC (IEC169-8) 

Impedance 75

Return loss > 25 dB, 0.1 to 6 MHz

Signal amplitude 1.0 V pk-to-pk ±10% into 75load

Audio rate 48 kHz (fixed) 

Jitter ±20 ns

Rise/fall time 30 ns to 44 ns (10% to 90%) 

Bits 24

Table 5-6  DVI Output Specifications

Item Specification

Standards DVI 1.0

Type DVI-I

Impedance 50

Amplitude 400 mV  Vswing  600 mV (single-ended)

Rise/fall time 75 ps  Risetime/Falltime  0.4 Tbit

Jitter 0.25 Tbit

Table 5-7  USB I/O Specification

Item Specification

Standard USB 2.0

Type A
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Ethernet I/O

Serial Ports

Power Consumption

Operating Temperature

Table 5-8  Ethernet I/O Specification

Item Specification

Standard IEEE 802.1

Type RJ45

Table 5-9  Serial Ports Specification

Item Specification

Standard  RS-232 (TIA-232-F) 

 ANSI/TIA/EIA-422-B 

 EIA-485

Type DB-26 to DB9 breakout cable

Ports Ports 1 & 2 - 232/422/485 switchable

Termination Ports 1 & 2: Optional internal 
termination is software-configurable
Ports 3 & 4: 232

Table 5-10  Layout Designer Power Consumption Specifications

Item Specification

Input power  250 W max from Platinum frame power 
supply

Table 5-11  Operating Temperature Specification 

Item Specification

Operating Temperature 41° to 113°F (5° to 45°C). 
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Propagation Delay
Table 5-12  Propagation Delay Specification 

Item Specification

Video delay  2 video frames/fields for DVI outputs

 3 video frames/fields for SDI outputs

Audio delay matching video delay
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A Frequently Asked Questions
Overview This chapter answers frequently asked questions (FAQs) and provides troubleshooting 
information about your HView SX Hybrid system. The FAQs are organized into the following 
categories:

 System FAQs answers some common questions about your multiviewer. See System 
FAQs on page 77.

 Video input and output display FAQs answer some common questions about video 
signals and display devices, as well as provide troubleshooting information about display 
devices. Video Input/Output Signals and Display Devices FAQs on page 77.

 CCS software FAQs answers common questions about using CCS software applications 
with your multiviewer.CCS Software Applications FAQs on page 79.

System FAQs What are FPGA Errors?
FPGA errors indicate a power-up initialization failure. Immediately after a power-on reset, a 
CPLD downloads firmware into programmable logic devices (known as FPGAs).

If an initialization fails, an LED on the affected xVIM module will light up (red) to indicate 
that the XVIM FPGAs are not configured. If this error occurred after a firmware upgrade, try 
running the upgrade again. 

What Is the Typical Video Delay of a HView SX Hybrid Unit?
The video delay is two frames/fields in DVI output mode, and three frames/fields in SDI 
output mode. 

Video Input/Output Signals and Display Devices FAQs

Why Does the External Display Attached to the VGA/DVI Output 
Have Poor Image Quality?
Most display problems can be traced to output display scaling artifacts or poor cabling. 
Correcting these errors usually requires either configuration changes or higher quality VGA/
DVI cables. If the picture has lots of speckles or mosquito noise, then the DVI cable is too 
long. 
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What are “Scaling Artifacts”?
Scaling errors can occur when a display device connected to a display output is forced to 
rescale an image by interpolating new pixels. This rescaling occurs because the display 
resolution generated by the output does not match the native display resolution supported 
by the display device. The interpolation process often introduces “scaling artifacts” that will 
soften or degrade the resultant displayed image. 

To avoid scaling errors, check the native resolution of the display device, and wherever 
possible, configure the output to match the display’s native resolution.

What is “Ghosting”?
“Ghosting” refers to vertical fringing artifacts. The use of incorrectly specified VGA cable or 
twisted pair connections most often causes this problem. Always use high-quality, 
RF-screened VGA cable with individual coaxial cables for each of the red, green, and blue 
signals of the VGA output.

What Calibration Adjustments are Necessary on the Attached 
Display?
To ensure a high-quality picture, you should always properly calibrate the attached display 
device, particularly digital display devices such as plasma displays and LCDs. 

If the Output Signal Fails, What Should Be Done?
Check the following:

 There is power to the output module and it is turned on (the On LED is green) 

 One or more valid input signal(s) are connected and the chosen PiPs or tiles correspond 
to valid input(s)

 If you are using SDI, make sure you are connected to HD monitors

 If the VGA output is used, make sure that the VGA monitor is capable of locking to the 
vertical scanning rate (50 Hz in 625 or PAL, 60 Hz in 525 or NTSC); use high-quality, 
RFI-screened, multiple 75 coax

 If you are using two DVI displays, make sure they are connected to displays of the same 
resolution, with the same vertical scanning rates

Why Do Some Video Tiles Appear to Have an Incorrect Format?
Check to see if you have selected the correct aspect ratio setting in Layout Designer.

Why Do Moving Images Jitter in Some Video Tiles?
This occurs when the total resources required to display layouts selected on all displays 
exceeds the defined system limitations. Review the used layouts and ensure they are withtin 
the capabilities of your multiviewer configuration. 
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What UMD/Tally protocols are supported by HView SX Hybrids?
The HView SX Hybrid supports the TSL protocol, Ross Tally, and a core subset of the Image 
Video protocol (not full protocol) on TCP/IP. 

CCS Software
Applications

FAQs

Is There a Specific CCS Application Version That I Need to 
Install?
Navigator 4.1 or later, and NUCLEUS 1.8 or later can be used with HView SX Hybrid. 
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B Servicing Instructions
Overview

CAUTION!

These servicing instructions are for use by qualified personnel only. To reduce the 
risk of electric shock, do not perform any servicing other than that contained in the 
operating instructions unless you are qualified to do so.

When servicing your HView SX Hybrid system, ensure that you take precautions to prevent 
electrostatic discharge (ESD). See “Appendix A: Safety Precautions, Certifications, and 
Compliances” in your Platinum Installation, Configuration, and Operation Manual for more 
information. 

These servicing instructions contain the following information:

 Battery Use Warning on page 81

 Changing the Battery on page 82

 Discarding the Used Battery on page 83

Battery Use Warning

If you need to replace the CR2032 battery in your Multiviewer, heed this caution:

WARNING!

Danger of explosion if battery is incorrectly replaced. Replace only with the same or 
equivalent type.

[FI Finland] VAROITUS: Paristo voi rajahtaa, jos se on virheellisesti asennettu. Vaihda paristo 
ainoastaan valmistajan suosittelemaan tyyppun. Havita kaytetty paristo valmistajan ohjeiden 
mukaisesti.

[SE Sweden] VARNING: Explosionsfara vid felaktigt batteribyte. Anvand samma batterityp 
eller en eller en ekvivalent typ som rekommenderas av tillverkaren. Kassera anvant batteri 
enligt fabrikantens instruktion. 
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[D Denmark]

[KO Korean]

Changing 
the Battery

Your output module has a CR2032 battery that may require replacement during the 
product’s lifetime. The battery allows the multiviewer to maintain some parameter options 
while it is powered down. Failure to replace the battery might lead to some parameters 
resetting to default factory values when the system is powered down.

To change this battery:

1 Remove the output module from the Platinum frame.

2 Using a small tool like a flathead screwdriver or pen, gently push the metallic tab on the left 
corner of the battery. 

An outward push on this metal tab will release the battery from its casing. 

3 Remove the battery.

Figure B-1  Battery Location Within its Casing

Advarsel! Lithiumbatteri. Eksplosionsfare ved fejlagtig 
handtering. Udskiftning ma kun ske med batteri af samme 
fabrikat oq type. Lever det brugte batteri tilbage till 
leverandoren. 

Push the tab 
gently away 
from the battery
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4 Replace the battery sliding the replacement battery into its casing.

5 Reinstall the output module in the Platinum frame.

Discarding the Used Battery
Dispose of batteries in a safe and proper manner in accordance with local regulations. Refer 
to the packaging instructions that accompany your replacement battery for more 
information.
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C UMD/Tally Option
The HView SX Hybrid offers optional under monitor display (UMD) support. This option 
provides a protocol interface (via RS-232, RS-422, RS-485, or TCP/IP) to different third-party 
UMD/tally generator systems in order to display UMD source identification and tally status 
information. This information automatically updates on-screen when it is changed by the 
tally system.

Image Video protocol colors map to the alarm states. Other tally systems that do not support 
color are mapped to the tally system color. 

Requirements for Optional UMD Support
The following items and installations are required to implement UMD support:

 A device that can generate UMD/Tally commands, for example, a UMD generator, 
production switcher, or router. The HView SX Hybrid supports the TSL protocol, Ross 
protocol (, D-Series protocol, and a core subset of the Image Video protocol (not full 
protocol) on TCP/IP. 

 One of the following cable connection options: 

 RS-485 cable connection between a multiviewer (COM 1–2) and a UMD/tally device 
(see Figure C-3 on page 87 and Figure C-4 on page 88)

 RS-422 cable connection between a multiviewer (COM 1–2) and a UMD/tally device 
(see Figure C-5 on page 89)

 RS-232 cable connection between a multiviewer (COM 1–4) and a UMD/tally device 
(see Figure C-6 on page 89)

 TCP/IP connection between a multiviewer and a UMD/tally device

Configuring UMD Data from the Platinum Frame
Regardless of where UMD and tally information comes from, the receiving item must be 
configured correctly in Layout Designer. Typically, UMD (Under Monitor Display) data 
contains the address, label and tally information and it is used to identify the PIP source 
name and the status of current condition. In HView SX Hybrid, the UMD data can come 
from either of the following locations: 

 Platinum input source names defined by the Navigator/RouterMapper application 

 An external protocol 
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With destination UMDs, if the video source to the PIP changes, the label or tally associated 
with the PIP remains static. 

Withc Source UMDs, the UMD data changes when the video source to the PIP changes. An 
external UMD device sends the appropriate UMD data to update the HView SX Hybrid. 

Figure C-1  Data Flow for Source UMD Updates 

Figure C-2  

In Figure C-2, you would set the following: 

 Tally State Source: UMD/Tally System (Fixed UMD addr) 

 Border State Source: UMD/Tally System (Fixed UMD)

 Label Text Source: UMD/Tally System (Source UMD) 

Sample System Configurations
This section illustrates some typical multiviewer to UMD device connections. 
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Figure C-3 illustrates a simplified system configuration with UMD/tally support.

Figure C-3  Typical RS-485 Four Wire Multidrop Configuration
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Figure C-4  Typical RS-485 Two Wire Multidrop Configuration
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Figure C-5  Typical RS-422 Point-to-Point Configuration

Figure C-6  Typical RS-232 Point-to-Point Configuration

Configuring TSL ASCII UMD Protocol 
TSL UMD protocol is configured in the External Communication tab of Layout Designer’s 
Advanced Configuration dialog box. 

1 Under Type, choose TSL Protocol. 

2 Under Port, choose the COM Port that TSL communication will be received through. 

3 Under COM, make the following selections: 

 Baud rate: 38400 bits/second

 Data bits: 8

 Parity: even
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Disable the termination resistor 
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 Stop (bits): 1

4 Click Add. 

Configuring Image Video UMD Protocol 
The HView SX Hybrid supports a core subset of the Image Video Protocol. The TSI-1000 
Image Video Tally Controller collects information from signal routing and processing 
equipment to operate displays and tallies as directed by its internal configuration 
information. 

To activate this option, in the Advanced Configuration window of Layout Designer, select 
the External Devices tab. 

1 Under Type, choose Image Video Tally. 

2 Under Port, choose the COM Port that TSL communication will be received through. 

3 Under COM settings, choose communication settings to match the settings on the Image 
Video unit. 

For RDU-1000 serial format, those settings should be: 

 Baud rate: 9600 bits/second

 Data bits: 7 

 Parity: Even

 Stop bits: 2

For RDU-1510 serial format:

 Baud rate: programmable to 300, 600, 1200, 2400, 4800, 9600, 19200, or 
38400 baud

 Data bits: 7

 Parity: Even

 Stop bits: 2

4 Click Add. 

To create labels: 
Syntax: %(Addr) D%1S(strings) %Z

#D: 1~255 (UMD Address)

String: <display string up to 17 characters>

5 %Z: Terminator

Table C-1  Color Block Coding

First Second Third Fourth Fifth

Text color Set tally 0 Set tally 1 Set tally 2 Set tally 3
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Configuring TSL v3, v4, and v5 over TCP/IP
TSL v3, v4 and V5 protocol over TCP/IP with the Hview being the TCP/IP server. 

1 From the main menu, select Edit > Multiviewer Configuration, and then click Advanced 
Configuration. 

2 From the Type menu, select TSL Protocol for V3, or TSL V4 or TSL V5. 

3 From the Port menu, select TCP/IP_S. 

4 Beside IP Port, enter the port number. 

5 With TSL v5, HView SX Hybrid supports following the protocol UMD and tally color 
information. To configure it, on the Tally Properties pane, select Edit Tally Colors. 

 On the Alarm Low tab, beside Primary Color, select Green. 

 On the Alarm Medium tab, beside Primary Color, select Amber. 

 On the Alarm High tab, beside Primary Color, select Red. 
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D Configuring Serial Ports 
Overview To change the mode of Serial Ports 1–4, you need to enter the BIOS.  You need a keyboard 
attached to the multiviewer module to enter the BIOS and make these changes. 

Topics described include: 

 Entering the BIOS on page 93

 Changing the Serial Port Operation Mode on page 95

 Changing Serial Port Termination on page 95

 Saving your Changes and Exiting the BIOS on page 96

Do not change any other settings in the BIOS.

Entering 
the BIOS

To configure the mode of serial port 1 or 2: 

1 Power cycle your Layout Designer module, or select Restart System from the Multiviewer 
Control Panel. (See Restarting the Multiviewer Control Panel on page 68.)

2 As soon as the motherboard starts, press the CTRL+SHIFT+B keys (for the original release 
BIOS) or B (for the new/current BIOS) on the keyboard.

The BIOS menu opens.
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Figure D-1  BIOS Menu

3 Press the right-arrow key on your keyboard to open the Advanced menu.

Figure D-2  Advanced Menu

4 Press the down-arrow key on your keyboard to scroll down to the SuperIO Configuration 
menu, and then press the Enter key. 
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Figure D-3  SuperIO Configuration Menu

Within the SuperIO Configuration section of the BIOS, you can change the mode of the 
serial port, and the termination type. 

Do not change any other settings in the BIOS.

Changing the Serial Port Operation Mode
Within the SuperIO Configuration section of the BIOS, follow these steps to change the 
mode of serial ports 1 and 2: 

1 Scroll down to COM1 Port Mode Select. 

2 Press the Enter key to open the Options screen to change between RS232 and RS422/485 
(default).  

3 Scroll down to COM2 Port Mode Select. 

4 Press the Enter key to open the Options screen to change between RS232 and RS422/485 
(default). 

The default for both Serial Ports 1 and 2 is RS422/485.

Serial Ports 3 and 4 are fixed RS-232 ports.

Changing Serial Port Termination 
Within the SuperIO Configuration section of the BIOS, follow these steps to change the 
termination setting of serial ports 1 and 2:

1 Scroll down to the COM1 RS422/485 120 OHM Termina. 

2 Press the Enter key to open the Options screen to change between No Termination and 
With 120 OHM Termination (default). 

3 Scroll down to the COM2 RS422/485 120 OHM Termina. 

4 Press the Enter key to open the Options screen to change between No Termination and 
With 120 OHM Termination (default). 

The default for both Serial Ports 1 and 2 is With 120 OHM Termination (termination 
enabled).
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Saving your Changes and Exiting the BIOS
After making your changes to Serial Port Operation Mode and Termination, you may want 
to save your changes. 

To exit the BIOS, do one of the following: 

 To save your changes and exit the BIOS, press the F10 key. 

The following message appears: 

Save configuration changes and exit setup?

With the arrow keys, select Ok to continue or Cancel to go back to the BIOS settings 
screen. 

 To exit the BIOS without saving your changes, press the ESC key. 

The following message appears: 

Discard changes and exit setup? 

With the arrow keys, select Ok to continue or Cancel to go back to the BIOS settings 
screen. 

Once you exit the BIOS, the multiviewer restarts with the new BIOS settings. 

All BIOS configuration changes will be lost when the battery replacement procedure as 
outlined in Servicing Instructions on page 81 is performed. 
pyright ©2011, Harris Corporation



97
Index
A
Advanced configuration 38, 52
AES audio output connector 7
AES monitoring output specifications 74
AFD parameters 48
Alarm indicators 4
Alarm summary 44, 49
Alarms 5, 43–49

module 49
PiP 45
reset 58
system 44

Applications 3
Audio

on-screen information 58
source select 58

Audio inputs, number of supported 12
Audio meters

on-screen context menu options 58–59
Audio monitoring outputs 17
Audio sample rates supported 74

B
Back module 4, 7

installing 13
Battery

changing 82
discarding 83
warning 81

Breakout box 9
Breakout cable 9

pinouts 18
Broadcast applications 3

C
Cable connections 17
CCS Navigator 3, 39–41

connecting to 15
Closed Captioning parameters 48
Communication connections 2
Communication failures 44

Configuration 35–39
external devices 54–56
JLCooper eBOX 54–56
overview 23

Connections
audio outputs 17
external 14
internal 11
output display devices 15, 17
serial 17
testing 37

Connectors, back module 7
Context menus

controlling a counter 60
on-screen controls 58–59

Control 39–68
Control panel, Multiviewer 65
Counter start time 45
Counters

on-screen controls 60

D
Database, router 28
DB-9 connectors 9
Default IP address 36
Default settings 44
Destination follow parameters 46
Discovery using Navigator 40
Display parameters 44
Display resolutions 16
Dolby E parameter 48
DVI output

configuration 52
connecting display devices 15, 17
connector 7
resolutions 73

E
eBox

configuration 54–56
connections 19–20

Ethernet connections 2, 15, 36
Copyright ©2011, Harris Corporation



Co

Index98
ports 7
to GPI 19

External device configuration 54–56
External update, label 63

F
Failure alarms 49
Failure indicators 5
Fan assembly 4
Features 1–3
Frame rates 72
Full screen parameter 46

G
Gamut parameter 46
GPI hardware interface 9
GPI input and output devices 19

H
Hardware interfaces 9
HD-SDI output

display resolutions 16
resolutions 73
specifications 72

I
Independent mode 16
Indicators, status 5
Initial counter time 45
Input power 75
Input reference signal 20
Inputs 1

GPI 19
router 28

Installation 11–21
back module 13
output module 13

IP address
default 36
setting 38

J
JLCooper eBOX

configuration 54–56
connections 19

K
Keyboard

using 60

L
Label properties 63

Labels
on-screen context menu options 58–59

Launch multiviewer 67
Layout

recall 59
Layout Designer 24, 36–39

advanced configuration 38
description 3
launching from Navigator 41

Layout name parameter 44
Layouts

switching on multiviewer 63
LED status indicators 5
Linear time code input 7, 20, 71
Lock display 59
Lock Display parameter 45
Log files 68
LTC input 7

connecting 20

M
Matrix, router 28
Module alarms 49
Module parameters 49
Module status LEDs 5
Monitor audio, on-screen options 58
Monitoring and control software 25
Monitoring audio outputs 17
Monitoring LEDs 4
Mouse

activating remote control 59
Multiple output monitors 16
Multiviewers

control panel 65–70

N
Navigator 3, 39–41

connecting to 15
Network, connecting to 15
New devices, adding in software 39
Non-broadcast applications 3
NUCLEUS 3, 25, 39–41

connecting to 15

O
On-screen control 57–70

activating remote mouse control 59
on-screen menus 57

Output display devices, connecting 15
Output display modes 16
Output display resolutions 16
Output modes 2
Output modules 4–5

adding to router database 29
discovering 40
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